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What’s New in This Guide

This section introduces the documentation updates for Release 14.0 in Oracle Communications LSMS Full Upgrade
Guide.

Release 14.0 — F91165-11, January 2026

e Added a note on choosing a method of root login after Procedure 15, Segmented Configuration for LSMS Cards and
Procedure 16, TMN Toolkit and Marben OSI License Installation.

e Updated step 9 of Procedure 19, Restore Database with the command to check if Isms status is UNINITIALIZED
"INHIBITED".

Release 14.0 — F91165-10, September 2025

e Updated step 14 in Procedure 11, Install the LSMS Application and added a note that default permission
and ownership will automatically be added to the config file for Ismsadm user.

o Edited step 10 in Procedure 19, Restore Database that Procedure 18 needs to be executed to verify the
system health check after DB full upgrade.

e Added a note to Procedure 22. that the procedure is only required when ELAP version is 10.2.

Release 14.0 — F91165-09, August 2025

e Updated the release versions in the Full Upgrade Paths table.

e Added a note in step 8 in Procedure 6, Backup LSMS DB that the edit supDBdump.sql to fix authorization
table command is only required while upgrading from 13.X release.

e Updated step 9 in Procedure 6, Backup LSMS DB with information on migrating from 14.0.0.X to 14.0.0.Y
by editing the file MySQLUserGrants.sql.

e Added step 14 in Procedure 11, Install the LSMS Application to create config file in the SSH directory

e  Updated step 6 in Procedure 19, Restore Database with a command to restore supDB.

Release 14.0 — F91165-08, April 2025

e  Added step 3 in Procedure 6, Backup LSMS DB to disable LSMS backup on both A and B servers

Release 14.0 — F91165-07, November 2024

e Addedthecommand # rm -rf /var/TKLC/lsms/free/<regionDB> to extractthe snapshot data
from the archive tar files copied from LSMS in step 5 in Procedure 19.

e Updated the command to exchange key with remote ELAP and LSMS in step 4 and 5 in Procedure 22.

e Removed step 7 from Procedure 22.

Release 14.0 — F91165-06, October 2024

e Updated the note about valid licenses to be installed on LSMS A and B servers in the Procedure 16, TMN
Toolkit and Marben OSI License Installation section.

Release 14.0 — F91165-05, September 2024



e Added a note in step 7 in Procedure 6, Backup LSMS DB to take a note of EMS configuration.

e  Added information about editing the MySQLUserGrants.sq]l filein Procedure 6, Backup LSMS DB.

e Added information about a warning displayed during the upgrade in step 11 in Procedure 11, Install the LSMS
Application.

Release 14.0 — F91165-04, September 2024

e Updated the Required Materials section to add reference to Release Notes to access the procedure to obtain the
license key files for Marben OSI and TMN Toolkit from Artifex for successful communication between
LSMS and NPAC.

Release 14.0 — F91165-03, August 2024

e Updated the Required Materials section.

e Added a note in the Upgrade Timeline for LSMS Procedure Execution Order section.
e Updated the note in step 4 in Procedure 6, BACKUP LSMS DB.

e Updated step 8 in Procedure 6, BACKUP LSMS DB.

e Updated Procedure 10, Configure Network Interface Using Platcfg Utility.

[ ]

[ ]

[ ]

[ )

Added a note in Procedure 15, Segmented Configuration for LSMS Cards.

Updated step 2 in Procedure 16, TMN Toolkit and Marben OSI License Installation.
Removed the Appendix “Procedure to Procure TMN and Marben Licenses”.
Replaced the reference to Appendix F with Appendix E throughout the document.

Release 14.0 — F91165-02, June 2024

e Added the procedure for SSH Key Exchange between ELAP and LSMS.
e Updated the reference to Procedure 22 in Timeline table for Maintenance Window Task.
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1. INTRODUCTION

1.1 Purpose and Scope

This document is designed to detail the steps necessary to upgrade the functionality of the LSMS 13.5.X. on ESAPPB-
02 to the LSMS 14.0.0.Y on the ESAPPB-02 cards.

This work is intended to be non-intrusive to the signaling network traffic and is to be performed within the limits of a
normally scheduled maintenance window unless otherwise stated.

It will be necessary to halt the provisioning activity during the execution of the procedures outlined herein while a full
database backup is being taken. Normal provisioning can resume once the full upgrade has completed. For any issues
incurred in executing any part of this document, follow the contact/escalation list.

The individual executing this procedure must be experienced and well proficient with the following platforms and
technologies.

e  Unix/Linux Admin

e VI Editor

e |P Networking

e  Oracle LSMS Platform E5-APP-B (TPD through Initial Implementation)

If you do not have these skills or if you are not completely comfortable working in Unix or Linux system environment,

STOP -DO NOT PROCEED

Full Upgrade for LSMS 14.0 14.0
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1.2 References

[1] Formal Peer Review, PD001866, latest version
[2] Work Instruction Template, TM005023, latest version

[3] Oracle Quality Manual, latest version

[4] TPD Initial Product Manufacture User’s Guide, 909-2130-001, Latest revision, Oracle
[5] ELAP 11.0 Full Upgrade/Installation Procedure, Current Version, Oracle
[6] Query Server Installation and Upgrade Instructions, Latest Version, Oracle

1.3 Acronyms

Table 1. Acronyms

BIOS Basic Input Output System

DB Database

E5-APP-B/ESAPPB Eagle5 Application Card class B cpu/board
ESAPPB-02 E5 Based Application card installed with 480G SSD Hard Drive
ELAP Eagle LNP Application Processor

IPM Initial Product Manufacture

LSMS Local Service Management System

NAS Network Attached Storage

NPAC Number Portability Administration Centre
QS Query Server

SERVDI Support ELAP Reload Via Database Image
TPD Tekelec Platform Distribution

MPS Multi Purpose System

1.4 Definitions

Table 2. Definitions

Active LSMS LSMS on which the sentry is running and it takes updates from the NPAC.

Standby LSMS LSMS on which data is replicated from the Active LSMS.

System health check Procedure used to determine the health and status of the LSMS server, typically
performed using the TPD syscheck utility.

1.5Terminology

Multiple servers may be involved with the procedures in this manual. Therefore, most steps in the written procedures
begin with the name or type of server to which the step applies. For example:

Each step has acheckbox for every commeard withon the step fhat the
fechyiciem showdd check fo keep frade of the progress of fhe procedure.

The fifle box describes the operafions fo be performed during that sfep.

Each commeand that the fechwicianis fo enfer isin 2 point Lucida Cansole fonf

\




1 | MPS A: Verify all | Materials are listed in Material List (Section 1.6)
D materials required
are present

Figure 1. Example of a step that indicates the Server on which it needs to be executed

1. | 1A | 18 | MPS X: Insert Insert media in USB drive
USB.
Ol O

Figure 2. Example of a step that needs to be executed on both MPS A and MPS B servers

1.6 Required Materials

e LSMS 14.0 works on OL8.x and needs license key files for Marben OSI and TMN Toolkit from Artifex for
successful communication between LSMS and NPAC. Make sure to get the two license key files from Artifex
before the scheduled upgrade date. Refer to LSMS 14.0 Release Notes, section 3.3: Marben OSI and TMN
Toolkit license key files, for details. Make sure to start the process at least 7 days before the scheduled upgrade
date.

e Two (2) target-release TPD USBs

o Two (2) target-release LSMS USBs or a target release LSMS ISO file.

e Aterminal and null modem cable to establish a serial connection.

e 100mbps link is required for database transfer to remote server.

o Remote Server or NAS server to store DB Backup before migration.

e TMN and Marben OSI license for OL8 server

e  Type of Network configuration single/segmented

e  System configuration information like NTP Server IP, App IP, ELAP IP etc.
Write down the system configuration information.
App IP:
App Gateway:
NTP Server IPs:

ELAP Server IPs:
NPAC Server IPs:
NPAC Customer ID:
NMS IPs:

Other IPs required:

Remote Server IP to copy DB Backup:

e  Passwords for users on the local system:

LSMS USERS
login MPS A password MPS B password
Ismsmgr
Ismsadm
Ismsall
Ismsuext

Full Upgrade for LSMS 14.0 14.0
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Ismsuser
Ismsview

root

mysql dbroot user
admusr
Command-line

Table 3: User Password Table

Note: After the MPS servers are IPM’ed with TPD 7.5.x, then “root” user access is disabled. “admusr” can be used if
required to access the MPS servers. After the installation of LSMS application the “root” user access is again enabled.

1.7 E5APPB Server (Rear)

Figure 3. E5-APP-B Server (Rear)

1.7 Switch Configuration

VLAN configuration on the switch is done based on the LSMS/NAS Segmented Type Configuration. Please note that
the VLAN IDs can be different based on the LAB network configuration.

Name [VTag| Rout If | Tagged ports | Untagged ports

default |1 | swO | [1/1/1-1/1/24

vlan2 |2 | |1/1/3,1/1/4 |

vlan3 |3 ||1/1/3,1/1/4 |

naspri-network |5 | [1/1/3,1/1/4,1/1/17 |



nassec-network |6 | |1/1/3,1/1/4,1/1/18 |
elap-network |159 | |1/1/3,1/1/4,1/1/19 |
gui-network |161 | |1/1/3,1/1/4,1/1/20 |

Optionally assign some name to the switch ports:

interface 1/1/3

name LSMS-A_NAS/ELAP/GUI
!

interface 1/1/4

name LSMS-B_NAS/ELAP/GUI
!

interface 1/1/17

name LSMS-A_NAS-pri

!

interface 1/1/18

name LSMS-B_NAS-sec

!

interface 1/1/19

name ELAP-network-uplink

!

interface 1/1/20

name Gui-network-uplink

1.8 Fallback

If for any reason a fallback to the original configuration is required, the procedure will be to re-IPM the server and

install the old LSMS version.

2. GENERAL DESCRIPTION

This document defines the step-by-step actions performed to execute a software full upgrade to ESAPPB-02.

The LSMS application can be installed or upgraded based on the table below.

Table 4 Install-Full Upgrade paths for ESAPPB-02

TPD Release for IPM LSMS Initial Installation Release
8.10.1.5.0_150.14.0 or later 14.0.Y
Full upgrade Source Release Full upgrade Destination Release
13.5.X 14.0.0.Y
14.0.0.X 14.0.0.Y

*Note : LSMS 14.0.Y is supported on ESAPPB-02 cards only

The LSMS upgrade paths are shown in the figures below. The general timeline for all processes to perform a software
upgrade, from pre-upgrade backups to a final system health check, is also included below.
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This document covers
migration from LSMS 13.5;to
LSMS 14.0

LSMS 13.5xyyy |™mmm . LSMS 14.0 .a-b.b.b

on an ESAPPB-02 Migrate on an ESAPPB-02

Figure 4: Full upgrade Path - LSMS 13.5.X to 14.0.Y

This document covers migration from
Migration from LSMS 14.0.0.X to 14.0.0.Y

LSMS 14.0.0.0.X LSMS 14.0.0.0.Y

On an E5APPB-02 On an E5APPB-02

Figure 5: Full upgrade Path - LSMS 14.0.0.X to 14.0.0.Y

3. FULL UPGRADE PROCEDURES
3.1 Upgrade Timeline for LSMS Procedure Execution Order

NOTE: Before starting the procedure make sure you have all the required information listed in section 1.6. Do
not proceed further until you have this required information, missing any information will be fatal post
upgrade.

3.1.1.1 Preparation phase

Before planning or starting Full Upgrade to LSMS 14.0 customer will have to procure TMN and Marben
Licenses for NPAC connection to work on OL8 post upgrade. Contact My Oracle Support (3.7Appendix E) to
procure the licenses.



Table 5: Timeline table for full upgrade preparation

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 1 Setup upgrade environment 5 0
5 5 | Setupupgrade Procedure 1
environment
Procedure 2 Pre Full upgrade Health 5 10 5 | PreFull upgrade Health Procedure 2
Check Check
Procedure 3 Verify LSMS QS 10 20
30
3.1.1.2 Maintenance Window Tasks
Table 6: Timeline table for Maintenance Window Task
LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Direct Disconnect 10 0
Procedure 5 SSH NPAC from
LSMS
Procedure 4 Disconnect
ELAP from
LSMS
Procedure 6 Direct Backup LSMS 120 10 10 | IPM MPS B Minicom | Procedure 8
SSH DB 0 | serverand NAS mate for
server MPS B
Transfer and
Procedure 7 Database to Minicom
Remote Server nas for
NAS
server
Full Upgrade for LSMS 14.0 14.0
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Pre-Install Minicom | Procedure 9
Configuration mate
Install the Minicom | Procedure 11
Application mate
Configure Minicom | Procedure 10
Network mate
interfaces using
platcfg utility
Configure Time | Minicom | Procedure 13
Zone and Clock. | mate
TMN Toolkit Minicom | Procedure 16
and Marben OSI mate
License
Installation
Procedure 8 Minicom | IPM MPS A 60 130
mate server
Procedure 9 Pre-Install
Configuration
Procedure 11 | Minicom | Install the 25 190
mate Application
Procedure 12 | Minicom | LSMS Initial 15 215
mate Configuration
Procedure 13 | Minicom | Configure Time 5 230
mate Zone and Clock.
Procedure 14 | Minicom | Network 10 235
OR mate Configuration
Procedure for LSMS Cards.
15.
*Note: For
Single Subnet
Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute
Procedure 15.
Procedure 16 | Minicom | TMN Toolkit 5 245
mate and Marben OSI
License
Installation
Procedure 17 | Minicom | Start LSMS 10 250
mate Services
Procedure 18 | Minicom | Post 5 260
mate Configuration

Health Check




Procedure 19 | Minicom | Restore Database | 60 | 265
mate
Procedure 20 | Minicom | Connect LSMS 15 | 325
mate 14.0.X to NPAC
Procedure 22 | Direct SSH Key 15 | 340
SSH Exchange
Between ELAP
and LSMS
Procedure 23 | Minicom | Connect LSMS 10 350 5 | Acceptthe Direct Procedure 24
mate 14.0.X to ELAP upgrade SSH
Procedure 24 | Minicom | Accept the 5 355
mate upgrade
Upgrade 355
Completed

3.1.1.3 Post Upgrade Phase

LSMS 1A LSMS 1B
Procedure Task 1A | Task 1B Task Procedure
Start
time
(min)
Procedure 21 | Export the Database from 60 0
LSMS 14.0.X to the Query
Server
60

3.2Install Procedures

This procedure will be executed for customers who are installing LSMS application on new server or are not using
LSMS application before this release. All other customers migrating from 13.5 release will have to follow Full Upgrade
Procedure.

3.2.1.1 Maintenance Window Tasks

Table 7: Timeline table for Maintenance Window Task

LSMS 1A LSMS 1B
Procedure Access Task 1A | Task | 1B Task Access Procedure
Method Start Method
time
(min)
Procedure 8 Direct IPM MPS A 120 0 0 | IPMMPSB Direct Procedure 8
Serial/Mi | server server and NAS Serial/Mi
nicom server nicom
Connecti Connecti
on on
Procedure 9 Pre-Install Pre-Install Procedure 9
Configuration Configuration

Full Upgrade for LSMS 14.0 14.0 016



Procedure 11

Procedure 13

Install the
Application

Configure Time
Zone and Clock.

Install the
Application

Configure Time
Zone and Clock.

Procedure 11

Procedure 13

Procedure 12 | Direct LSMS Initial 15 120
Serial/Mi | Configuration
nicom
Connecti
on
Procedure 13 | Direct Configure Time 5 135
Serial/Mi | Zone and Clock.
nicom
Connecti
on
Procedure 14 | Direct Network 10 140
OR Serial/Mi | Configuration
Procedure 15 | nicom for LSMS Cards.
Connecti
on *Note: For
Single Subnet
Configuration
execute
Procedure 14
and for
Segmented
Subnet
Configuration
execute
Procedure 15.
Contact Procure Procure TMN - - | Procure TMN Procure Contact
Oracle TMN License License TMN Oracle
Support License License Support
Note: Timing to Note: Timing to
acquire TMN acquire TMN
license may wary license may
depending on wary depending
Artifex team on Artifex team
availability. availability.
Procedure 16 | Direct TMN Toolkit 5 150
SSH and Marben OSI
License
Installation
155 5 | TMN Toolkit Direct Procedure 16
and Marben OSI SSH
License
Installation
Procedure 17 | Direct Start LSMS 10 160
SSH services
170 10 | Start LSMS Direct Procedure 17
services SSH




Direct Post 5 180

Procedure 18 | SSH Configuration
Health Check
185 5 | Post Direct Procedure 18
Configuration SSH
Health Check
Procedure 20 | Direct Connect LSMS 15 | 190
SSH 14.0.X to NPAC
Procedure 23 | Direct Connect LSMS 10 205 5 | Acceptthe Direct Procedure 24
SSH 14.0.X to ELAP upgrade SSH
Procedure 24 | Direct Accept the 5 215
SSH upgrade
Upgrade 220
Completed

3.3Pre Full upgrade Steps
Check off (\) each step as it is completed. Boxes have been provided for this purpose under each step number.

Should this procedure fail, Contact My Oracle Support following the instructions on the Appendix E.
Procedure 1 SETTING UP FULL UPGRADE ENVIRONMENT

Procedure 1 - Setting Up Full upgrade Environment

S . .
T This procedure sets up the full upgrade environment.
A B . . .
E Estimated time: 5 minutes
#
. SSH to MPS IP:
MPS X:
1 U Login as root to MPS Togin: root
Password: <root_password>
MPS X: Start a capture file using Iso Console, or by
2 1 O . ) starting a local screen session and capturing
Start capture file. its output.
MPS X:
3. (1l 1| Access mate MPS via # minicom mate
serial console
] console Togin: root
4 Ol O mate MPS: Password: <root_password>
' Login as root.
This procedure is complete!

Procedure 2 PRE-FULL UPGRADE SYSTEM HEALTH CHECK

Note: This procedure may be executed outside of the maintenance window.
This procedure determines the health of the MPS before and after full upgrade.

Estimated time: 5 minutes

P lom-dwn

MPS A and B: Log in to Login: root
] the server as the user “root”. Password: <root_password>

Full Upgrade for LSMS 14.0 14.0 018
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MPS A and B:

Validate date, time and time
zone to ensure accuracy.

# date
Thu May 12 05:55:27 EDT 2016

w

MPS A and B:

Execute the “hastatus”
command to verify the HA
state of this server.

Execute the following command on both LSMS A and B to verify the HA state of
mated LSMS pair.

# hastatus
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than

“ACTIVE” and “STANDBY™, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.

&~

L]

LSMS Standby server:

Verify that the STANDBY
server’s MySQL replication
is functioning properly.

Execute the following command to verify that MySQL replication is working
correctly on the STANDBY LSMS server:

# tail /var/TKLC/1sms/logs/dbrepIMon. log

If MySQL replication is functioning correctly then the following output will be
observed, make sure that at least the last line of your output matches the lines
below.

Thu
Thu
Thu
Thu

Dec 07 05:58:12 2017 A1l tests passed on STANDBY
Dec 07 05:59:19 2017 ATl tests passed on STANDBY
Dec 07 06:00:25 2017 ATT tests passed on STANDBY
Dec 07 06:01:32 2017 Al1l tests passed on STANDBY

WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.

LSMS Active server:

Verify that the ACTIVE
server’s MySQL replication
is functioning properly.

Execute the following command to verify that MySQL replication is working
correctly on the ACTIVE LSMS server:

# tail /var/TKLC/Tsms/1ogs/dbreplmon. log
If MySQL replication is functioning correctly then the following output will be

observed, make sure that at least the last line of your output matches the lines
below.

Thu Dec 07 05:58:12 2017 All
Thu Dec 07 05:59:19 2017 All
Thu Dec 07 06:00:25 2017 All
Thu Dec 07 06:01:32 2017 All

tests passed on ACTIVE
tests passed on ACTIVE
tests passed on ACTIVE
tests passed on ACTIVE

WARNING: If at least the last line of your output does not match the lines above
then do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.




o

]

MPS A and B:
Execute syscheck

# syscheck

Running modules in class disk...
oK

Running modules in class services...
OK

Running modules in class system...
oK

Running modules in class lIsmshc...
OK

Running modules in class hardware...
OK

Running modules in class proc...
OK

Running modules in class net...
OK
LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log

~

L]

LSMS Active server:

Capture the output of
‘sentry status’ command

Execute the following command on the ACTIVE LSMS server to display the
current LSMS sentry status:

# sentry status

NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment
field. If the output from this command displays any other Status than “running”
contact My Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

LSMS Active server:

SSH to NAS server and
execute syscheck.

# ssh backupserver
# syscheck

Running modules in class disk...
OK

Running modules in class services...
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OK

Running modules in class system...
OK

Running modules in class Tsmshc...
OK

Running modules in class hardware...

OK
Running modules in class proc...

OK
Running modules in class net...

OK

LOG LOCATION: /var/TKLC/log/syscheck/fail_log

[{e]

Note down the Time zone

Note the time zone which will be required to be configured post upgrade.

# su - lsmsmgr

Select Server Configuration and press [ENTER].
Main Menu |—

Initial Configuration
Maintenance
Diagnostics

Hetwork Configuration
Exit

Select Time Zone and press [ENTER].
- Server Configuration Menu |

S5et Clock

Time Zone

Exit

The screen shows the current time zone setting.




R RSN ] qoggqu Options tgggggk +

mogggggj mggggga]
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10| Repeat on the day of the All Health Checks should be repeated the day of the full upgrade. If any problems
| scheduled full upgrade are encountered, resolve before proceeding further.

This procedure is complete!

Procedure 3 VERIFY LSMS QUERY SERVER

Procedure 3 - Verify LSMS Query Server

? This procedure determines if the LSMS 13.5 has an Optional Query Server.
E . . .
p | Estimated time: 10 minutes
#
1. | LSMS Active server: Login: Tsmsadm
]| Logintotheserverasthe | Password: <Ismsadm_password>
user “Ismsadm”.
2. LSMS Active server:

o $ /usr/TKLC/Tsms/tools/1smsdb -c queryservers
[]| Verifyifthe Query Server | /usr/TKLC/1sms/tools/Tsmsdb: Query Server Feature is not
Feature is active on the enabled.

LSMS System. ———OR---

cs2-bss2 (<LSMS Query Server IP>) Connected
___OR___
cs2-bss2 (<LSMS Query Server IP>) Disconnected

LSMS Active server:

1| Note down the Query
Server IP Address (es).

w

If the Query Server exists on the LSMS System, note the IP address (es) for later use.

This procedure is complete!

3.4 Data Backup before Full upgrade

Procedure 4 DISCONNECT ELAP FROM LSMS

Procedure 4 - Disconnect ELAP from LSMS
This procedure disconnects the ELAP from LSMS.Estimated time: 5 minutes

Note: This procedure needs to be executed on all the connected ELAPS.

HoOmAHdwnmw
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L \E/Ie_r'?\fs é‘l‘j%’f 1sgr2vfr:s:tall NOTE: Verify the following.

[ ' 1. ELAP10.2 is successfully installed and configured.
2. ELAP 10.2 is connected to Eagle for data download

2. | LSMS Active server: Login: 1smsadm

1| Loginto the server as the Password: <1smsadm_password>

user “Ismsadm”.
3. | LSMS Active server: $ eagle status
0 gli_sg\%””ec" the connected Look for all connected ELAPs and disconnect each of them.
S

$ eagle stop <ELAP CLLI>
eagle: Sto?pi ng...
eagle: eagleagent STPA stopped at Tue Apr 26 05:48:52 2023

4. | ELAP Active server: . ) )

[7| Login to ELAP GUI Login to the ELAP (connected to LSMS) GUI through VIP as uiadmin.

5. | ELAP Active server: .

7| Disable the Bulk Download Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Disable LSMS Bulk Download for this ELAP’ button.
ELAP_A_NA[VIE Change LSMS HS Bulk Download Enabled

i INFO: The LSMS Bulk Download for this ELAP is currently Enabled.

A CAUTION: This action will Disable the LSMS Bulk Download for this ELAP
{ Disable LSMS Bulk Download for this ELAP
ELAP_A_NAME Change LSMS HS Bulk Download Enabled
V SUCCESS: The LSMS Bulk Download for this ELAP is now Disabled.

6. | ELAP Active server: Got Maint LSMS C i ch Enabled

. 0 to menu Maintenance -> onnection -> Change Enable
O g:)s:r?gitﬁgi LSMS Click on ‘Disable LSMS Connection’ button.

ELAP_A_NAME Change LSMS Connection Allowed

1 INFO: The LSMS Connection is currently Enabled.

& CAUTION: This action will Disable the LSMS Connection.

Disable LSMS Connection

2013 © Tekelec, Inc., All Rights Reserved.

ELAP_A_NAME Change LSMS Connection Allowed

v SUCCESS: The LSMS Connection is now Disabled

Thu December 26 2013 22:55:58 ES

2013 © Tekelec, Inc, All Rights Reserved.




~

All connected ELAPs:

Disconnect LSMS
connection

Repeat the steps 4 to 6 for all ELAPSs connected to LSMS.

This procedure is complete!

Procedure 5 DISCONNECT NPAC FROM LSMS

Procedure 5 - Disconnect NPAC from LSMS

? This procedure disconnects NPAC from LSMS.
E | Estimated time: 5 minutes
P
#
1. LSMS Active server: Login: Tsmsadm
[] | Logintotheserverasthe Password: <lsmsadm_password>
user “Ismsadm”.
2. | LSMS Active server: Execute the following command to list the active NPAC regions
] | Stopall connected NPAC $ dbnames -n all -a
regions Canada CanadaDB
MidAtTantic MidAtlanticDB
Midwest MidwestDB
Northeast NortheastDB
Southeast SoutheastDB
Southwest SouthwestDB
westCoast WestCoastDB
western westernDB
Note: The above output shall vary depending on LSMS configuration.
Note: Store this output as it will be required during DB restore phase post
upgrade.
Execute the following command to stop an NPAC region.
$ 1sms stop <region name>
Checking if npacagent 1is running. ..Yes.
Stopping npacagent....
oK.
npacagent stopped: wed Jan 2 05:52:42 2014
Ccommand complete.
Execute the above command for all active regions.
3. | LSMS Active server: ) )
[] | Loginto LSMS GUI Login to LSMS Active GUI through VIP as ‘Ismsall’ user.
4. | LSMS Active server: Click on the NPAC reqi
[] | Deactivate all active regions Ick on the region.

Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Uncheck the ‘Activate Region’ checkbox and click ‘OK’.
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%.@ Modify LNP System NPAC <Canada, primary> (==

SMS MName |Regions MPAC Canada Activate Region

Address Info | Component Info Contact Info | Comm Info

MPAC O3] Address

PSEL |Cw? SSEL |ow? TSEL NSAF (10 248 (10 |5

Lahds Q5] Address

PSEL psel SSEL szel TSEL NS&P 10 248 10 78

WPAC FTP Address

10 248 |10 |5

@ Modify NPAC Component?

OK Cancel

Note: Similarly, Deactivate all the active NPAC regions.

This procedure is complete!

Procedure 6 BACKUP LSMS DB

Procedure 6 - Backup LSMS DB

? This procedure outlines the steps to backup the LSMS DB.
E | Estimated time: 90 minutes
P
# | NOTE: The estimated time may differ depending on the DB size.
1 LSMS Active server: Login: root
: ) : Password: <root_password>
] | Loginto the server as the
user “root”
2. LSMS Active server: # 1smsdb —c counts
] | Record DB counts
8 LSMS Active a.nd . Run the following command on both LSMS A and B to disable LSMS backup:
Standby Server: Disable | # sed -1 "/A#/! {/1smsbkp_wrapper/ s/A/#/3}'
LSMS backup on both A | /etc/cron.d/1smsbkp.cron
and B servers
4. LSMSAthVE_J Server: # rm —rf /var/TKLC/1sms/free/mysql-snapshot-*
(] | Remove existing DB # rm -rf /var/TKLC/Tsms/free/snapinfo.sql

snapshots




] | Backup the LSMS DB

5. LSMS Active server: Execute below command to verify “QUERY_SERVER” and
“RESYNCDB_QUERY_SERVER?” feature is enabled:
] | Enable - -
“QUERY_SERVER” and # 1smsdb -c features | grep -w QUERY_SERVER
“RESYNCDB_QUERY_S # 1smsdb -c features | grep -w RESYNCDB_QUERY_SERVER
ERVER” Feature
If these features are not enabled then execute the below commands to enable them:
) . . # su — Tsmsadm
Note: Even if Query Serveris | g dhcfginternal QUERY_SERVER Y
not connected this step is Provide the “Customer Service ID”
required to take backup $ dbcfginternal RESYNCDB_QUERY_SERVER Y
Provide the “Customer Service ID”
$ exit
6. LSMS Active server:

# Tsmsdb -c snapshot

WARNING: This command may cause a brief interruption in
traffic being sent from the NPAC to connected network
elements and local LSMS provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...

File descriptor 5 (socket:[34104267]) leaked on lvcreate

invocation. Parent PID 28676: /usr/TKLC/1sms/tools/1smsdb
Logical volume "dbbackup" created

The database is available to the application again.

Disk snapshot created successfully.

Snapshot mounted successfully.

Created snapinfo.sql file successfully

MidAtlanticDB/

MidAtTanticDB/NumberPoolBTlock.frm

MidAtlanticDB/ServiceProvNetwork.MYD

Logica] volume "dbbackup"™ successfully removed

Note: The execution time of the above command shall vary according to the DB
size.

Verify that the following snapshot files are created at /var/TKLC/Isms/free
directory:

e mysgl-snapshot-noreplDB.tar.gz

e mysqgl-snapshot-supDB.tar.gz

e mysgl-snapshot-<regionDB>.tar.gz
snapinfo.sql

LSMS Active server:

] | Verify the snapshot files for
all existing NPAC regions

~

Execute the following command and verify that the snapshot files are created for
all the NPAC regions listed in the command output.
Note: The below command shows only the regions for which the DB exists.

# 1smsdb -c dblist
CanadaDB
MidAtTanticDB
MidwestDB
NortheastDB
Rep1TestDB
SoutheastDB
SouthwestDB
WestCoastDB
westernDB
TogDB

mysq’l
norepl1DB

performance_schema

supDB
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8. LSMS Active server: ) i
O Run the following command on LSMS Active server CLI to take MySQL dump
of the supDB database.
Take MySQL dump of supDB. | # mysqldump -udbroot -p[dbroot_password] supDB >
/var/TKLC/Tsms/free/supbBdump.sql
Note: Take a note of EMS Note: Below warning messgge caﬂ be ignoge?_if disp]gyed:
; ; warning: Using a password on the command 1line interface can
configuration (IP, user, Group) be insecure.
and delete the same on LSMS.
Note: Do not run the following command when upgrading from
14.0.0.X to 14.0.0.Y. This command is only required while
upgrading from 13.X release.
Edit supDBdump.sql to fix Authorization table
# sed -1 's/function/functions/g' supbBdump.sql
9. LSMS Active server: o o .
[ Create MySQLUserGrants.sql file listing all the users and their privileges using
Take MySQL dump of the following shell script MySQLUser.sh in the root directory:
mysql.user.

File: MySQLUser.sh
MYSQL_CONN="-udbroot -ppassword"

mysql ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT('SHOW CREATE USER '"',user,'''@''',host,''';') FROM
mysql.user WHERE user<>''" | sed '/mysql/d' | mysql
${MYSQL_CONN} --skip- column-nameés -A | sed 's/$/;/g9"' | sed
"s/IDENTIFIED WITH 'mysql_native_password' AS/IDENTIFIED
BY/g" | sed "s/IDENTIFIED WITH
'mysql_native_password'/IDENTIFIED BY/g" | sed "s/REQUIRE
NONE PASSWORD EXPIRE DEFAULT ACCOUNT

UNLOCK//g" > /var/TKLC/1sms/free/MysQLUserGrants.sql

mysqgl ${MYSQL_CONN} --skip-column-names -A -e "SELECT
CONCAT("SHOW GRANTS FOR ''",user,'''@''',host,''';"') FROM
mysql.user WHERE user<>'"" | mysql ${MYSQL_CONN} --skip-
column-names -A | sed 's/$/;/9' |sed 's/IDENTIFIED BY
PASSWORD/IDENTIFIED BY/g' | sed '/mysql/d' >>
/var/TKLC/1sms/free/MySQLUserGrants.sql

Note: Edit MYSQL_CONN for the proper connection properties and this will
generate the MySQLUserGrants.sql file with grant statements from the 5.7
machine that you can source into the 8.0 machine.

Run the MySQL User.sh file to generate MySQL UserGrants.sql

# chmod +x MysQLUser.sh
# ./MysQLUser.sh

Run command to edit MySQLUserGrants.sql
# sed -i 's/CREATE USER/CREATE USER IF NOT EXISTS/g'
MySQLUserGrants.sq]l

The content of the MySQLUserGrants.sql will be:
GRANT USAGE ON *.* TO 'Tsmsadm'@'%' IDENTIFIED BY
'57570851ac3cc01499';

Edit the .sql file and replace the password of all the users with plain text password

to contain something like:
GRANT USAGE ON *.* TO 'lsmsadm'@'%' IDENTIFIED BY 'password-
in-plain-text';

Run below commands to recover plain text password for default Isms users:
For dbroot user:




/usr/TKLC/Tsms/tools/pass_fetch
passl

For materepl user:

/usr/TKLC/Tsms/tools/pass_fetch pass3 -> materepl

For cmdline user:

/usr/TKLC/1sms/tools/pass_fetch pass4 For other default
users:

/usr/TKLC/Tsms/tools/pass_fetch pass2
Remove entry for “Ismsrepl” @ <Ismsgs IP>" from the
MySQLUserGrants.sql. Thiswill be added during LSMSQS configuration.

Note: There is no way to reverse the hash to recover the plain text. So the
customer has to provide us the plain text passwords for users which were added
by customer.

Editthe MySQLUserGrants.sql file and edit the second line:
CREATE USER IF NOT EXISTS 'dbnopriv'@'%'IDENTIFIED BY;
Here ‘’ are missing after IDENTIFIED BY ;

Example: CREATE USER IF NOT EXISTS 'dbnopriv'@'%'
IDENTIFIED BY ‘’;

For migration from 14.0.0.X to 14.0.0.Y edit the file
MySQLUserGrants.sql

Remove below two lines in MySQLUserGrants.sql:

GRANT SELECT, INSERT, UPDATE, DELETE, CREATE, DROP,
RELOAD, SHUTDOWN, PROCESS, FILE, REFERENCES, INDEX, ALTER,
SHOW DATABASES, SUPER, CREATE TEMPORARY TABLES, LOCK
TABLES, EXECUTE, REPLICATION SLAVE, REPLICATION CLIENT,
CREATE VIEW, SHOW VIEW, CREATE ROUTINE, ALTER ROUTINE,
CREATE USER IF NOT EXISTS, EVENT, TRIGGER, CREATE
TABLESPACE, CREATE ROLE, DROP ROLE ON *.* TO dbroot @ %’
WITH GRANT OPTION;

GRANT

APPLICATION_PASSWORD_ADMIN, AUDIT_ABORT_EXEMPT,AUDIT_ADMIN,A
UTHENTICATION_POLICY_ADMIN,BACKUP_ADMIN,BINLOG_ADMIN,BINLOG
_ENCRYPTION_ADMIN, CLONE_ADMIN,CONNECTION_ADMIN, ENCRYPTION_K
EY_ADMIN, FIREWALL_EXEMPT , FLUSH_OPTIMIZER_COSTS, FLUSH_STATUS
, FLUSH_TABLES, FLUSH_USER_RESOURCES , GROUP_REPLICATION_ADMIN,
GROUP_REPLICATION_STREAM, INNODB_REDO_LOG_ARCHIVE ,INNODB_RED
O_LOG_ENABLE , PASSWORDLESS_USER_ADMIN, PERSIST_RO_VARIABLES_A
DMIN,REPLICATION_APPLIER,REPLICATION_SLAVE_ADMIN,RESOURCE_G
ROUP_ADMIN, RESOURCE_GROUP_USER,ROLE_ADMIN,SENSITIVE_VARIABL
ES_OBSERVER, SERVICE_CONNECTION_ADMIN,SESSION_VARIABLES_ADMI
N,SET_USER_ID, SHOW_ROUTINE,SYSTEM_USER,SYSTEM_VARIABLES_ADM
IN, TABLE_ENCRYPTION_ADMIN, TELEMETRY_LOG_ADMIN,XA_RECOVER_AD
MIN ON *.* TO “dbroot @ % WITH GRANT OPTION;

Add below line at the end of MySQLUserGrants.sql:

“GRANT ALL PRIVILEGES ON *.* TO 'dbroot'@'%' WITH
GRANT OPTION;”
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10. | LSMS Active server: Login to LSMS GUI as Ismsall user.
] | Log intothe Active LSMS
server GUI
11. | LSMS Active server: Goto “Admi MVSOL P ew and dth fiured MvSOL P
[] | Record the configured oto min -> MySQL Port -> View” and record the configured MySQL Port.
MySQL Port
12| LSMS Active server: Go to “Confi LNP Syst EMS -> Vi d record the configured
. o to “Configure -> ystem -> -> View” and record the configure
[ 1 | Record the configured ELAP ELAP Credentials.
Credentials
13. | LSMS Active and Standby ) ) ]
[ | Server Login to LSMS CLI and take back up of the below 2 files from both Active and

Copy and Backup license
file when upgrading from
LSMS 14.0.0.X release

Standby server:
/usr/TKLC/os1i/conf/1icense
/usr/local/netech/etc/Ticense

These licenses will be required after full upgrade is complete

This procedure is complete!

Procedure 7 TRANSFER DATABASE TO REMOTE SERVER

Procedure 7 - Transfer Database to Remote Server

? This procedure transfers the database backup from the LSMS server to the remote server.
E | Estimated time: 30 minutes
P
# | Note: 100mbps link is required for database transfer to remote server.
. ] Login: root
- LSMS Active server: Password: <root_password>
[ | Loginto the server as the
user “root”
2. LSMS Active server: # ping <remote IP> —c 3
1| Verify Connectivity f
between the LSMS and the PING <Remote IP> (<Remote IP>) 56(84) bytes of data.

remote server.

If the remote server cannot
be pinged, verify the
network connectivity.

64 bytes from <Remote IP>: icmp_seq=1 ttl=64 time=0.022 ms
64 bytes from <Remote IP>: icmp_seq=2 ttl=64 time=0.020 ms
64 bytes from <Remote IP>: icmp_seq=3 ttl1=64 time=0.020 ms

--- <Remote IP> ping statistics --- ]
3 packets transmitted, 3 received, 0% packet loss, time
2001ms




rtt min/avg/max/mdev = 0.020/0.020/0.022/0.005 ms

1| Copy snapshot filesto a
Remote Server.

3. LSMS Active server: # 1s -1rt /var/TKLC/1sms/free/*snapshot*
]| Listthe snapshot files # 1s -1rt /var/TKLC/1sms/free/supbBdump.sql
# 1s -1rt /var/TKLC/1sms/free/MySQLUserGrants.sql
4. | Remote server: # rm /var/TKLC/1sms/free/mysql-snapshot-*
]| Remove the existing DB # rm /var/TKLC/Tsms/free/supDBdump.sql
snapshot files # rm /var/TKLC/Tsms/free/MySQLUserGrants.sql
5. LSMS Active server:

Transfer all the NPAC region DB snapshot files, the MySQL dump of supDB and
the MySQL dump of mysql.user

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,

NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
# scp -p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>.tar.gz root@<Remote IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/supbBdump.sql root@<Remote
IP>:<Remote IP Path>
Password: <root_password>

# scp -p /var/TKLC/1sms/free/MySQLUserGrants.sql
root@<Remote IP>:<Remote IP Path>
Password: <root_password>

or
# cd /var/TKLC/1sms/free/

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computers>...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC region>.tar.gz
Uploading mysql-snapshot-<NPAC region>.tar.gz
sftp> put supbDBdump.sql

Uploading supDBdump.sql

sftp> put MySQLUserGrants.sql

Uploading MySQLUserGrants.sql

sftp> bye

IS

Remote Server:

[ | Verify the snapshot files are
present on the remote
Server.

# Is -Trt /var/TKLC/Tsms/free/*snapshot*
# 1s -1rt /var/TKLC/1sms/free/supbDBdump.sql
# 1s -1rt /var/TKLC/1sms/free/MySQLUserGrants.sql

This procedure is complete!
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3.5IPM and LSMS 14.0.X Installation

Procedure 8 IPM MPS SERVER WITH 64 BIT TPD 8.6.X

Procedure 8 - IPM MPS Server with 64 bit TPD 8.6.x

1. MPS X: Reboot server

Ol Ol 0| msetTPoeex | # reboot
USB media into the
USB port

2 MPS X:

Press ‘del’ key to
enter the BIOS.
Enter System Time
and System Date.

3. MPS X:

Select Boot > Hard
Disk Drives option

* Hard Disk Drives -

4 MPS X:

Press ‘Enter’ key
Oy oo and select USB as
the 1% Drive




5 MPS X:

Press ‘Esc’ key and
select Boot Device

1st Drive

{USE:SHART USB]

Prlorlty * Boot Device Priority
HINEAEE
6. MPS X:
Verify that the 1%
Boot Device is set ) aree
to USB. 13t Boot Devige [USB:SHART USB]
OO d

2| U U] U | mpsx:
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Press ‘Esc’ key and
select Exit > Save
Changes and Exit
option

n PCIP Boot Cr T Ex1t)
TR ARSI RAATTAARTAASIAANIARNTIANTIANTIANT AR I ARTI AN AN ARTIARIIARNTRRTIRRRER

* Exit Options * Exit system setup *
T ATIITATTATITEATLIRTIIBATIRATIIATIIANITARCRANLAAANLAT T after saving the *
E * changes. i
* Discard Changes= and Exit s ]
* Discard Changes * F10 key can be used .
= * for this operation. -
* Load Optimal Defaults 2 ¥
* Load Failsafe Defaults by *
* * *
* * *
= * .
* * =
- o Select Screen '
E EErs Select Item x
* * Enter Go to Sub Screen *
® £ F1 General Help *
x * F10 Save and Exit B
- * ESC  Exit *
* B *
S * 2
AR A R R AR R AR SRR RS R A A RS R R R R Rt R R RSt R R kRS

opyright 1985

8. MPS X:
i i d P i 4 Chipset Ex1
Select [OK] to Sa.ve P R A R R R R R R R A R R R R TR AR R RS AR A SRR R SRRSO SRERSRRASRARRRSRAS
the Configuration * Exit Options * Exit system setup s
T RN RN AN AR LA R RN LRI IR INSRRIRIRLRRLERRLIRNLLY atter sav].ng the *
changes. : e :
* Discard Changes and Exit * &
. * Discard Changes * F10 key can be used :
The server will ' * for this operation. *
reboot and TPD T Load Optlml Dttf!t?tttttt:fi*ttxtt:tttttt!ttttt‘lztttf?tittttx T
- * Load Failsafe * 1 *
bOOt prompt WI" E * Save configuration changes and exit setup? # 3
appear. : * ! A
T AR AR R R R R AR RS R RS RAs Rttt 1
t * [Cancel] 3
T LR R R R R R R R R R R R R R R R RS AR R R t Screen L]
T T
e * Enter Go to Sub Screen *
T * F1 General Help L
< * F10 Save and Exit 2
* * ESC  Exit E
T * T
T * T
AR RS R R R R AR AR R R R R R AR AR AR AR AR AR AR S RS RRR R R AR RN ARttt ]
% MPS X:
Start the IPM
process by entering
the TPDIvm
command at the
boot prompt.
ISOLINUX 6.04 Copyright (C) 1994-2015 H. Peter Anvin et al
10.

MPS X:




After a few seconds,
additional messages
will begin scrolling
by on the screen as
the Linux kernel
boots, and then the
drive formatting and
file system creation
steps will begin.

TonTIguring JCoTrags
Creating disklabel on /Jdewv/sdb
Creating mdmember on Jdewv/sdob2
Creating bioskboot on /dev/adbl
Creating disklabel on /Jsdewv/sdc
Creating mdmember on JSdev/sdc2
Creating lvmpv on /dev/md/l

Creating ext4d on /dev/mapper/vgroot—-plat_var_ tklc

Creating ext4 on /dev/mapper/vgroot—plat
Creating extd4d on Jdev/mapper/vgroot-—-plat

tmp
aus T
var

Creating ext4 on /dev/mapper/vgroot—plat
Creating swap on /dev/mapper/vgroot—plat
Creating extd on /sdev/mapper/vgroot—plat
Creating kioskboo on Jdewv/sdcol

=wap
root

Running pre-—installation scripts
Running pre—installation tasks
Installing.

Starting package installation process
Downloading packages

1. MPS X:

Once the drive
formatting and file
system creation
steps are complete,
the screen at right
will appear
indicating that the
package installation
has begin.

Liseariing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing
Installing

Ccldng-—resource-1lliesysLell. Xxoo_ 04

\LL/2/L0U1)

adwaita-cursor-theme.noarch (1176/1507)
adwaita-icon-theme.noarch (1177/1507)

gtk3.x86 64 (1178/1507)
gjs.x86_64 (1179/1507)

adobe-mappings-pdf.noarch (1180/1507)

libgs.x86 64 (1181/1507)
graphviz.x86_64 (1182/1507)
python3-pydot.noarch (1183/1507)

python3-pygraphviz.x86 64 (1184/1507)

ghostscript.xz86 64 (1185/1507)
cups.x86 64 (1186/1507)
cups-filters.x86_ 64 (1187/1507)

python3-networkxz.noarch (1188/1507)
gnome-characters.x86 64 (1189/1507)
libcanberra-gtk3.x86_64 (1190/1507)

libgnomekbd.x86 64 (1191/1507)
libtimezonemap.x86_ 64 (1192/1507)
firewalld.noarch (1193/1507)

Installing open-vm-tools.x86 64 (1194/1507)
Installing TPD-upgrade.ncarch (1195/1507)
Installing TKLCeSappb.noarch (1196/1507)

|

12 MPS X:

Once all the
packages have been
successfully
installed, the screen
at right will appear
letting you know the
installation process
is complete.

Remove USB
media before
Reboot.

MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Media already mounted.
DEV: /dev/sda
MPOINT:
Pulling ISO Metadata file from: /run/install/repo//.isometadata
Copying IS0 metadata file to system
DIR: /mnt/sysimage/var/TKLC/log/ipm
Copying IS0 metadata file to prodinfo
DIR: /mnt/sysimage/usr/TKLC/plat/etc/prodinfo
Changing default target to application.target
Revoke root ssh access
Installation complete

Use of this product is subject to the license agreement found at:
/usr/share/oraclelinux-release/EULA

Installation complete. Press ENTER to guit: I
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On MPS server
press <ENTER> to
reboot the system
and continue with
the next step.

13. MPS X:
Press ‘del’ key to
enter the BIOS
System Time
14 MPS X:
Select Boot = Hard
Disk Drives option
s Hard Dis}é ﬁrivaé
15.

MPS X:




Press ‘Enter’ key
and select HDD:PO
as the 1% Drive

ist Drive

[HOD: PC-INTEL SSDSC)

16.

MPS X:
Press ‘Esc’ key and

select Boot Device
Priority

% Boot Device Priority

17.

MPS X:

Verify that the 1%
Boot Device is set
to HDD:PO.
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ist Boot Device

[HDD:PO-INTEL S5DSC])

18.

MPS X:

Press ‘Esc’ key and
select Exit - Save
Changes and Exit
option

Save Changes and Exit

19.

MPS X:

Select [OK] to save
the configuration
changes. The server
will reboot.




Nain Advanced PCIPnP Boot Security Chipset JExit]
P R R e L T e e T T e E T R R L I E S T T A LT T

* Exit Options # Exit system setup *
T IR IR R TR IR IRENRRNLRSRTRRNRITRINRNRAZRNENENZY X afl’.er SBVlng ghe =
% * changes, g
* Discard Changes and Exit x &
* Discard Changes # F10 key can be used ]
8 * for this operation. 8
L3 Load wglml D‘ltlttltttlt‘lI8ttl‘lIItlt?tltll!ililtt!t!!tl‘f‘t!t‘l x
* Load Failsafe * - &
= * Save configuration changes and exit setup? 7 ®
T T A .
T ARt ARRRRRRRARRRRRRRRRRRRRRRRRdtd »
. s m [Cancel) s E
T AR RARARARARARARRRARRRRRARERRRRRARARRRARRRES D T SCIeen .
T 4
. * Enter Go to Sub Screen *
. L g General Help .
o * F10 Save and Exit *
z * ESC  Exit .
L 3 L3 2
* L3 2

B L L R ]

When the message ""Upstart Job ntdMgr: started", is displayed, press the
Enter Key to get the Login prompt.

20. MPS X: Log in to Oracle Linux Server 8.7

Kernel 4.18.0-477.27.0.1.e18 8.x86 64 on an x86 64
the server as the — — _

HigEIgE user “root”

localhost login: root
Password: [

21. MPS X: # getPlatRev

Verify that the 8.6.0.x.0-110.y.0
O o) o platform revision is
same as the 1ISO
used.

This procedure is complete!

Procedure9 PRE INSTALL CONFIGURATION

Procedure 9 — Pre-Install Configuration

This procedure will perform the initial configuration required for LSMS installation.
Estimated time: 15 minutes
Note: Below procedure needs to be executed on both MPS A and MPS B servers.

MPS X: Log in to Login: root
0o theserverasgtheuser Password: <root_password>

“root”

H+oOmMm-Aw
>
lov)

0| O MPS X: Switchuser | # su - platcfg
to platcfg.

Select “Server
Configuration” Menu
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4| Main Menu |7

Maintenance
Diagnostics

REemote Consoles
Hetwork Configuration

Security

Exit
MPS X:
Select “Hostname” 4 Server Configuration Menu F
Menu

Ho s tname
Designation/Function
Configure Storage
Set Clock

Time Zone

Exit

MPS X: Changethe | select Edit and press [ENTER]
host name.

1) Select “Edit” from — options |—

the options dialogue
box.

2) Set the hostname

4' Edit Hostname Ii

Select OK and press [ENTER].




Note: While connected to the serial console, some console output might come
when the user is using the serial console to configure the LSMS. Those serial
output are harmless and can be ignored.
5. MPS X: )
0|4 Hostname Configuration
Verify that the
Hostname is correct
then select and press
“Exit”.
. Current Hostnsame:
Otherwise repeat the
step above.
6. MPS X: Navigateto | select Designation/Function and press [ENTER]
the Designation
Information screen.
4 Server Configuration Menu F
Hostname
Designation/Function
Configure Storage
S5et Clock
Time Zone
Exit
7.
(1| O] MPsSX:
1) Select “Edit”
from the options
dialogue box.
2) Set the
Designation as “1A”
on Server A and as
“1B” on Server B,
Function as “LSMS
and press “OK”.
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NOTE:

Designation and
Function should be
entered in
UPPERCASE.

——— Edit Designation [——

Designation:
Function:

MPS X:

Verify that the
Designation and
Function is correct
then select and press
“Exit”.

Otherwise repeat the
step above.

Designation Information

Designation: 1a
Function: L3HM3

MPS X: Exit the
platcfg menu

NOTE:
DO NOT set the

time zone in platcfg.

The time zone will
be set later in initial
configurations.

Select Exit and press [ENTER] to return to the Main Menu.
Server Configuration Menu

Hostname
Designation/Function
Configure Storage
S5et Clock

Time Zone

Select Exit and press [ENTER]. The “platcfg” utility terminates.




———] Main Menu |——

Maintenance
Diagno=stics

Server Configuration
Remote Consoles
Hetwork Configuration

This procedure is complete!

Procedure 10 CONFIGURE NETWORK INTERFACE USING PLATCFG UTILITY

Procedure 10 — Configure Network Interfaces using platcfg utility

Network Configurationjel
Exit

$ This procedure configures the network interfaces and makes the ESAPPB servers accessible to the network.
E | B | Estimated time: 5 minutes
p
#
) Console Login: root
L[ DI| wesx: Password: <root password>
Login as root
user.
> | OJ| wps x: # su - platcfg
Login to
platcfg utility
3| O] mps x: lgggggqu Main Menu tgggggggk
Configur B =
NO“NmLe ¥ Maintenance X
€ fr ¥ Diagnostics a x
Interface £ Server Configuration a x
£ Remote Consoles a x
¥ Security X
4 X
4 X
4 X

ngggagaaaaaaaaaaaaaaaaaaaad
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lu Network Configuration Menu tk

]

SNMP Configuration
Routing

Configure Network
Network Bridges
CHRONY

Iptables

Resolv

IPSEC Configuration
Stunnel

Modify Hosts File
Exit

[ O T VA T T
I R

]

nggggaggaagaaggaagaaaqgaagqaaagad

lu Network Interfaces Menu tk
b4 b4
% Add an Interface b4
Il dit an Interface b4
2 Delete an Interface a ¥
2 Restart an Interface a ¥
% Exit b4
b4 b4
1 Connection to edit Menu k
X 3
% bond0 %
X 3
e %
2 %
X 3
2 %
2 %
b4 4

usEles(s(o(s(s(sle(s s (a(e(s(o(e(s s (o (e (e (o (e(e g

————4 Options F—————




4| O] mps x:

Select
Interface
Options

lgggggggqu Interface Options tqggggggggk
vru: [

GRO:

GS50:

hwaddr:
BootProto:

T T T T T A B A A
e T T T L O R

[ulslalalalalalaiais ainiaiaiaiaisis alalalnialsiaislisiainialalaiaislslalalam
—| Configure Ethtool Options I—

Would wou like to configure Ethtool Cptions?

I Configure IP Address I

Would you like to configure IP addresses?

4 Choose IP Address Version Menu

IFvE
Exit
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— ] Choose I

(*) Add Addres=zs

Choose Address } Edit Address

} Delete Address

MPS X:
Input the IF Lddress: INPEENRSIELE
Interface Hetmask: Rl Lt
Address Start on Boot: d

Liwve:

] Message I
Interface Edited
Press any kKey Tto continmuae. ..
Select “Exit” until you exit from the platcfg utility.

MPS X: -4 Network Configuration Menu F
Conﬂ@ne SNMMP Configuration

default route.

Network Interfaces
Network EBridges
Configure MNetwork
Routing

MNTF

Iptables=

IFPIEC Configuration
Resolw

Stunnel

Modify Host=s File
Configure Zwitch
Exit
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Add default Route gqgggggggk

Device: < > bondO
< > bond0.2
<o0> ethO
< >» ethl
< > eth?
< > eth3
Gateway: 10.250.50.1

I T S

@Y Cancel

HeEEEEEEEEEEEEEEEEEEEEEEEEEE

cc

Select “Exit” until you exit from the platcfg utility.

Procedure 11 INSTALL THE LSMS APPLICATION

Procedure 11 - Install the LSMS Application

This procedure installs the application on the server.
Estimated time: 25 minutes

Note : Below procedure needs to be executed on both MPS A and MPS B servers.

2lsom-4w
>
w

MPS X: Log in to Console Login: root
IR console the server as | Password: <root_password>

the user “root”

2. MPS X: Perform
O o Procedurein 3.7A.1
or copy LSMS
14.0.X 1SO to
Ivar/TKLC/upgrade
directory.

3. MPS X: Start # su - platcfg
0o platcfg utility by
logging in as platcfg
user.

4. MPS X: Early The platcfg Main Menu appears.

O O
upgrade checks On the “Main Menu”, select Maintenance and press [ENTER].




lgggggqu Main Menu tgggggqagk

X X
velMaintenance X
% Diagnostics ¥
% Server Configuration a =
% Network Configuration a x
% Remote Consoles a x
x Security a
x Exit b4
4 X

mogaaagaaaaaaaaaaaaaaaaaacd

Select the “Upgrade” menu and press [ENTER].

lggggu Maintenance Menu tggggqgk

Dual Image Upgrade

i)

Upgrade

Patching
Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Platform Data Collector

Exit

T R L
AT I +¥ R VI ]
T T T T T T T

uls(e{s(oe(s(s(e(e(s(e(s(o(e(s(s(s({s(o(e(s (s (e (o (o(e (o)

Select the “Early Upgrade Checks” menu to verify that the system is ready for
upgrade.

lggggggqu Upgrade Menu tggggggqggk

Validate Media

Early Upgrade Ch

Initiate Upgrade

Copy USB Upgrade Image
Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

w

BRI
T T TR T
A T B

wislelo(e(elo(eeloie(e(oie(e(ofe(elo(o(e(o(o(e (el e (e (o e (e (ol

Select the desired upgrade media and press [ENTER].

lqgaqqgaqqaaaqqaadaqaqu Choose Upgrade Media Menu tgqagaggaqqaadqaadaddaak

% %|
pell.SMS—14.0.0.0.0 140.6.5- 64.1is0 — 14.0.0.0.0 140.6.5 X
2 Exit b4
b4 %]

m9q9qq9999999999999999999999999999939999999999999999999999994IIIIIIIT ]
If the Early Upgrade Checks fail due to the ongoing syncing of raid mirrors, then
follow the steps 5 and 6 to ignore the disk mirroring before the LSMS installation. If
the Early Upgrade Checks passed then jump to Step 7.
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Early Checks failed for the next upgrade

Look at earlyChecks.log for more info

tarting Early Upgrade Checks at 1011413059

Funning earlyUpgradeChecks () for Upgrade::EarlyPolicy::TPDEarlyChecks upgrade policy...
Verified serwver is not pending accept of previous upgrade

ERROR: Raid wirrors are syncing!

ERBOR: md2 is syncing!

ERRCOR: earlyUpgradeChecks () code failed for Upgrade::EarlvyPolicy::TPLDEarlyChecks
ERROR: Failed running earlyUpgradeChecks()] code

Hardware architectures match

Install products match.

No Application installed yet.. Skip alarm check!

ERROR: Early Upgrade Checks Failed!

User has requested just to run early checks.

No upgrade will be performed...

Early Upgrade Checks finished at 1011413059

[adwusrepappri ~]14§ cat /proc/mdstac

Personalities : [raidi]

mdl : active raidl sdbi[l] =sdazZ[0]
262080 blocks super 1.0 [2/2] [UU]

mdZ  active raidl sdal[0] sdbl[1]
468447232 bhlocks super 1.1 [272] [UU]

[S====2 . . i nnn ] resyne = 29.7% (139377920/468447232) finish=73.0min speed=75060KE/sec
bitmap: 4/4 pages [16HB], E5536KE chunk

unused devices: <none>

Contact My Oracle Support following the instructions on the Appendix E, if the early
upgrade checks fail due to any other reason.

MPS X: Exit the
platcfg menu

Select Exit and press [ENTER] to return to the Maintenance Menu.

lqgadaqaaqaadaqaaqaqu Choose Upgrade Media Menu tqggaqqaaaqgaddaqdadak

% b4
x LSMS-14.0.0.0.0 140.6.5-x86 64.is0 - 14.0.0.0.0 140.6.5 b4
|k %
4 b4

[rgaggggagagqagagqagqagqagdaaqddaqaddagdaqaaqdagdagddqadqdagdgdaqaaagdgdgqagqagdadaagqagd

lggggggqu Upgrade Menu tggggggggk

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image

Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

AT ¥ R T

BRI

Select Exit and press [ENTER] to return to the Main Menu.




lggggu Maintenance Menu tggqqgk
X X
¥ Dual Image Upgrade %
¥ Upgrade a
¥ Patching a
x Backup and Restore a ¥
% View Mail Queues a x
¥ Restart Server a X
x Save Platform Debug Logs a ¥
x Platform Data Collector %
X X
-4 b4
ueEEEEEtEEettEEEEetEtEEEEEEEEEn)

Select Exit and press [ENTER]. The “platcfg” utility terminates.

lgggggqu Main Menu tggggqgqggk
x X
x Maintenance =
% Diagnostics a
% Server Configuration a
x Network Configuration a x
% Remote Consoles a X
® Security %]
KA X
X X
is(e(e(sfe(e(e(e(s(o(e(e(a(o(e(s e (e (s(e(s(e (e (s (e (o)

6. MPS X: Ignore disk

O o mirroring before # echo "IGNORE_EARLY_CHECKS=1" >
LSMS installation /var/TKLC/log/upgrade/tmp_upgrade.conf

Verify:
# cat /var/TKLC/Tog/upgrade/tmp_upgrade.conf
IGNORE_EARLY_CHECKS=1

7. Ol 0 MPS X: Validate On the platcfg “Main Menu”, select Maintenance and press [ENTER].

the Upgrade media lggggggu Main Menu tgggggggk
b4 |

edlMaintenance 2|

Use the “Arrow” x Diagnostics x
and the [ENTER] % Server Configuration a x
: % Network Configuration a x|

keys to na_\”gate the % Remote Consoles a =
Menu options as % Security 2 =
showntochoosethe | [z Exit =
upgrade media. - 4
magaaoaaaaaaaaaaaaaaaaaaaaada
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Press any key to
return to the menu
and then press Exit
all way back to the
Maintenance Menu

lggggu Maintenance Menu tgggggk]

Dual Image Upgrade
1) =

Patching

Backup and Restore
View Mail Queues
Restart Server
Save Platform Debug Logs
Platform Data Collector
Exit

v

R L U
T TRV T
o I

lee(s(ele(ele(=(s e lole(o(= (o (= o= (o= (o= (= (o (e (o]

lgggggggu Upgrade Menu tggggggggk

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USB Upgrade Image

Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

WO M MW M M W XN
ppoo
A

s e ie(e s e (e = e (o (o= oo (e = e (e = e (e (e (= (e (S Le (= (o (=

Laggaqggadagqaqggadaqu Choose Upgrade Media Menu tggqggaqqaqaaqaaaaadak]

q9qgqgaIgIqIqIaIgIqIqIgIqIqIqIgIqIqIqIgIqIqIqIgIqaqaqIqaqaqaqIqaqadd]

The results of the validation will be displayed, similar to the
example beTlow.

Press the “enter” key to continue.




[ EE s RS EE RS IR RS SRR EEEEEEEEEE RS EEEE RS EEEE ST EE]
FhEdFFE A AR AR AR A A A AR R R R A R R
FhEEEEF SRR AF SRR A RS R AR AR AR AR AR R A S
FREFEEF SRR AF SRR AF SRR A RS AR R A AR R AR AR R A S
thEFE A RA SRS A AR A RS RS A
FhEdFFE A AR AR AR A A A AR R R R A R R
FhEEEEF SRR AF SRR A RS R AR AR AR AR AR R A S
FREFEEF SRR AF SRR AF SRR A RS AR R A AR R AR AR R A S
thEFE A RA SRS A AR A RS RS A
FhEdFFE A AR AR AR A A A AR R R R A R R
FhEEEEF SRR AF SRR A RS R AR AR AR AR AR R A S
FREFEEF SRR AF SRR AF SRR A RS AR R A AR R AR AR R A S
thEFE A RA SRS A AR A RS RS A
FhEdFFE A AR AR AR A A A AR R R R A R R
FhEEEEF SRR AF SRR AA SRR AR AR AR AR AR AR R A S
FREFEEFEFEEAF SRR AR SRR AFE RS E RS S R A AR SRR A AR A RS AR A S
FhEdFF A AR A S AR A AR AR R R R A R R R
FhEEEF AR A A AR AR A AR A AR A A R A 4
FhEEEEF SRS F SR AA SRR AR AR AR AR AR R AR R A S
FREFEEFEFEEAF SRR AR SRR AFE RS E RS S R A AR SRR A AR A RS AR A S
FhEdFF A AR A S AR A AR AR R R R A R R R
FhEEEF AR A A AR AR A AR A AR A A R A 4
FhEEEEF SRS F SR AA SRR AR AR AR AR AR R AR R A S
FREFEEFEFEEAF SRR AR SRR AFE RS E RS S R A AR SRR A AR A RS AR A S
FhEdFF A AR A S AR A AR AR R R R A R R R
FhEEEF AR A A AR AR A AR A AR A A R A 4
FhEEEEF SRS F SR AA SRR AR AR AR AR AR R AR R A S
FhEEEEF SR REAF SRR AR SRR AR S

IJMVT Validate Utility v2.3.4, (c)Tekelec, May 2014
validating /var/TKLC/upgrade/LSMS-14.0.0.0.0_140.6.5-x86_64.is0
Date&Time: 2023-12-16 06:37:36

Volume ID: 14.0.0.0.0 140.6.5

Part Number: N/A

Version: 14.0.0.0.0_140.6.5

Disc Label: LSMS

Disc description: LSMS

The media validation is complete, the result is: PASS

CDROM is Valid

PRESS ANY KEY TO RETURN TO THE PLATCFG MENU.

8. MPS X: Navigate to
0| o the Initiate Upgrade
menu.

Use the “Arrow”
and the [ENTER]
keys to navigate the
Menu options as
shown to choose the
upgrade media.

Select the Initiate Upgrade menu and press [ENTER].

lggggggqu Upgrade Menu tgggagggagk

Validate Media
Early Upgrade Checks

W

Initiate Upt le

Copy USB Upgrade Image
Non Tekelec RPM Management
Accept Upgrade

Reject Upgrade

Exit

T R T Y
A T Vi ¥
T T T T T O T

Mg999q999I9I999I99I999999999999999997

The screen displays a message that it is searching for upgrade media. When the
upgrade media is found, an Upgrade Media selection menu appears similar to the
example below.

Select the desired upgrade media and press [ENTER].
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lqggqagqgaqgaqagdadqaaqu Choose Upgrade Media Menu tgggggaqqaadadqdqaqqaqak

. - 14.0.0.0.0 140.6.5 b4
x Exit b4
2 b4
qqqqaaqaqqqqqaqaqdqaqqaqaqaqqaaqqaqaqaqaqqaqaqqaqqqaaqaaqqqaaqaaadqaqdaadd

MPS X:
Upgrade proceeds

The screen displays the output like following, indicating that the upgrade software is
first running the upgrade checks, and then proceeding with the upgrade.

Mo Application installed yet.. Skip alarm check!
Verified all raid mirrors are svnced.

Early Upgrade Checks Have Passed!

Early Upgrade Checks finished at 1447425031
Initializing upgrade information...

Many informational messages appear on the terminal screen as the upgrade proceeds.
The messages are not shown here for clarity sake. When installation is complete, the
server reboots.

10,

MPS X: Upgrade
completed

After the final reboot, the screen displays the login prompt as in the example below.

1462266947 Upstart Job TKL Csnmp-subagent: started

CEgr g Ky gF gy Ky gy 00 FE Ay 40 FY PF YA FY PEIQ LY IE
i LA I L T o R TR

1462266947 Upstart Job syscheck: started

CEgr g Ky gF gy Ky gy 00 FE Ay 40 FY PF YA FY PEIQ LY IE
i LA I L T o R TR

1462266947: Upstart Job tpdProvd: started

Crgrip EY gF gy Xy gy 0d FE AP 40 FY PF YA FY PE IS LY IE
i LA I L i T o TR TR

1462266949: Upstart Job ntdMgr: started
B s S

Oracle Linux Server release 6.7
Kernel 2.6.32-573.18.1.el6prerel7.0.3.0.0_86.44.0.x86_ 64 on an x86_64

lsmspri login:

11.

MPS X:
Login as root user.

Login: root
Password: <root_password>

12,

MPS X:

Check the upgrade
and warnings

# grep -i error /var/TKLC/Tog/upgrade/upgrade.log
1724760824 : :ERROR: Command returned non-zero exit code 256
(systemct1 start TKLCpTdhcp)

# grep -i error /var/TKLC/log/upgrade/ugwrap.log

# grep -i warning /var/TKLC/log/upgrade/upgrade.log
1724760624 : :WARNING: TKLClsms-Config-2.0.4-14.0.0.1.0_140.9.0:
current hostname "Steak-B" being reset to default.
1724760681: : TKLCIsms warning: user %{root}
does not exist - using root

1724760681: :warning: group %{root} does not exist - using root
1724760759: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1724760971: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1724760971: :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/TsmsAlarms.xm]l

#

# grep "Up?rade returned success"
/var/TKLC/Tog/upgrade/upgrade.log




1248284646:: Upgrade returned success!

# grep -i error /var/TKLC/log/upgrade/upgrade.log

only below error is expected

1512594958: :ERROR: Command returned non-zero exit code 768
(/sbin/service TKLCpldhcp start)

# grep -i error /var/TKLC/log/upgrade/ugwrap.log
There should be no error output.

# grep -i warning /var/TKLC/log/upgrade/upgrade.log
The following warning are expected:

The following warning are expected:

1512594173: :WARNING: /usr/TKLC/plat/etc/alarms/alarms.xml has
been updated...reparsing xml...

1512594265: :warning: erase unlink of /etc/ssm/hwmgmtd.conf
failed: No such file or directory
1512594267 : : kexec-tools #warning:

/etc/kdump.conf created as /etc/kdump.conf.rpmnew

1512594414 : :setup
HHHRHHH RS R R R fwarning
/etc/shadow created as /etc/shadow.rpmnew

1512594430: :ca-certificates #i# R warning :
/etc/pki/tls/certs/ca-bundle.crt created as
/etc/pki/tls/certs/ca-bundle.crt.rpmnew

1512594464 : :warning: user mysql does not exist - using root

1512594464: :warning: group mysql does not exist - using root
1512594464 : :warning: user mysql does not exist - using root
1512594464: :warning: group mysql does not exist - using root

1512594464::2017-12-06 16:07:44 0 [warning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: New Tlog
files created, LSN=45781

1512594465::2017-12-06 16:07:44 14331 [warning] InnoDB: Creating
foreign key constraint system tables.

1512594467::2017-12-06 16:07:46 0 [warning] TIMESTAMP with
implicit DEFAULT value is deprecated. Please use --
explicit_defaults_for_timestamp server option (see documentation
for more details).

1512594468 :WARNING: Default config file /etc/my.cnf exists on
the system

1512594469: : samhain warning: /etc/samhainrc
created as /etc/samhainrc.rpmnew

1512594473 : php-common #warning: /etc/php.ini
created as /etc/php.ini.rpmnew

1512594551 :initscripts ##warning:
/etc/sysctl.conf created as /etc/sysctl.conf.rpmnew

1512594603: :ntp warning: /etc/ntp.conf
created as /etc/ntp.conf.rpmnew

1512594615: : TKLCplat ###### SRR #warning

/usr/TKLC/plat/etc/pid_conf created as
/usr/TKLC/plat/etc/pid_conf.rpmnew
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1512594615: :#warning: /usr/TKLC/plat/etc/service_conf created as
Jusr/TKLC/pTlat/etc/service_conf. rpmnew

1512594630: : TKLCalarms ###warning:
/usr/TKLC/plat/etc/alarms/alarms.xm] saved as
/usr/TKLC/pTlat/etc/alarms/alarms.xml.rpmsave

1512594637::alarmmgr ###warning:
/usr/TKLC/plat/etc/alarmmgr/alarmmgr.conf created as
/usr/TKLC/plat/etc/alarmmgr/alarmmgr. conf. rpmnew

1512594770: :WARNING: This capability is not defined in the
default capabilities.

1512594770: :WARNING: Nor is it defined in the current hardware
ID's capabilities.

1512594770: :WARNING: CAPABILITY: service disabled
1512594770: :WARNING: HARDWARE ID: ESAPPB

1512594885: : sudo warning: /etc/sudoers
created as /etc/sudoers.rpmnew

1512594922 : :WARNING: TKLCIsms-Config-1.4.9-13.2.1.0.0_132.22.0:
current hostname "lsmspri" being reset to default.

1512594923: :WARNING: Hostname not changed because it is the
same.

1512594966: :WARNING: Could not write to config file /usr/my-
new.cnf: Permission denied

1512594966: :Installing MySQL system tables...2017-12-06 16:16:06
0 [warning] 'THREAD_CONCURRENCY' is deprecated and will be
removed in a future release.

1512594966::2017-12-06 16:16:06 31217 [warning] The option
innodb (skip-innodb) is deprecated and will be removed in a
future release

1512594966::Filling help tables...2017-12-06 16:16:06 O
[warning] 'THREAD_CONCURRENCY' 1is deprecated and will be removed
in a future release.

1512594966::2017-12-06 16:16:06 31220 [warning] The option
innodb (skip-innodb) is deprecated and will be removed in a
future release

1512594966: :WARNING: Could not copy config file template
/usr/share/mysql/my-default.cnf to

1512594966: :WARNING: Default config file /etc/my.cnf exists on
the system

1512594972 : :WARNING: A new file was added to xml alarm
files...reparsing xml...

1512594972 : :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/TsmsAlarms.xml

1512594974 : :WARNING: Module variable EXPECTED_CPUS is
deprecated!

1512594975: :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1512594975 :WARNING: Module variable EXPECTED_CPU_ALM 1is
deprecated!

1512594975: :WARNING: CONFIG:
/usr/TKLC/plat/1ib/Syscheck/modules/system/cpu/config

1702719042 : :WARNING: TKLCIsms-Config-2.0.3-0.70555: Current
hostname "1smspri" being reset to default.




1702719098: : TKLClsms
HHHHHHHHH T ###warning . user %{root} does not
exist - using root

1702719104: :warning: group %{root} does not exist - using root

1702719175: :WARNING: Could not dup STDERR to STDOUT: Bad file
descriptor

1702719391: :WARNING: A new file was added to xml alarm
files...reparsing xml...

1702719391 : :WARNING: FILE:
/usr/TKLC/plat/etc/alarms/TsmsAlarms.xml

13,

MPS X:

Verify LSMS
release.

# rpm -gqi TKLClsms

14

Create config file in
ssh directory :

Do not run this if
ELAP is already
upgraded to ELAP11

Run below steps on both servers after installation is complete:

switch to Ismsadm user

cd .ssh

Create a config file using *vi config* in the /var/TKLC/Isms/Ismsadm/.ssh with
below content

Host *

HostKeyAlgorithms +ssh-rsa

PubkeyAcceptedKeyTypes +ssh-rsa

Note:- Default permission and ownership will automatically be added to this file
for Ismsadm user

Switch back to root user

Add ssh-rsa at the end of the line:

For example:

HostkKeyAlgorithms ssh-ed25519,ssh-ed25519-cert-
v0l@openssh.com,ecdsa-sha2-nistp384,ecdsa-sha2-
nistp384-cert-v0l@openssh.com,rsa-sha2-512, rsa-sha2-
512-cert-v0l@openssh.com,rsa-sha2-256,rsa-sha2-256-
cert-v0l@openssh.com,ecdsa-sha2-nistp256,ecdsa-sha2-
nistp256-cert-v0l@openssh.com,ecdsa-sha2-
nistp521,ecdsa-sha2-nistp521-cert-
v0l@openssh.com,ssh-rsa

Restart sshd service using the below command:

systemct] restart sshd

Perform steps 1-6 on mate server.

This procedure is complete!

3.6 Initial Configuration

Procedure 12 LSMS INITIAL CONFIGURATION
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Procedure 12 - LSMS Initial Configuration

Enter password for “Ismsadm” Select
OK and press [ENTER]

S | This procedure does the initial configuration on the LSMS servers.
E Estimated time: 15 minutes
P
#
1. | MPS A: Log in to the server as the Login: root
Ol user “root” Password: <root_password>
2. | MPSA: # su - lsmsmgr
O} start Ismsmgr utility by logging in as
Ismsmgr user
3. | MPS A: —— Main Menu [—
[
Select “Initial Configuration”
Diagnostics
Server Configuration
Hetwork Configuration |
Exit
4. | MPSA:
] —] Select running options |——
Select “yes”
Select OK and press [ENTER]
5 | MPSA:
] - Query for FirstTimeConfig::0l0EevExchange |5
Enter root password: _
Enter password for “root”
Select OK and press [ENTER]
6. | MPSA: - fuery for FirstTimeConfig::01Z2AdmFeyExchange |
[

Enter lsmsadm password: _




MPS A: —| fuery for FirstTimeConfig: :013RootAdmUsrEevyExchange |—

Enter admmsr password: _

D.\l

Enter password for “admusr” Select
OKand press [ENTER]

Full Upgrade for LSMS 14.0 14.0 058



ks

MPS A:

Enter the NAS password used to
login into NAS console. Accept the
default serial port (ttyS2) when
prompted for the path to the NAS
console device.

Select OK and press [ENTER]

———————————— Query for FirstTimeConfig::05BackupConfig ———

Enter the NAS root password for NAS configuration:: _

[]°

A message is displayed indicating the root Key Exchange was successful.

A message is displayed indicating the Ismsadm Key Exchange was successful.

A message is displayed indicating the admusr Key Exchange was successful.

A message is displayed indicating the Time Synchronization was successful.

A message is displayed indicating the Database creation was successful.

A message is displayed indicating the NAS Backup Configuration was successful.

A message is displayed indicating the inhibiting of the node was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

10. MPSA: #ssh mate
Ll switch to mate
11.| MPS B: # su - lsmsmgr
Ll
Start Ismsmgr
12.| MPS B: ———] Main Menu |—
[]
Maintenance
. . Diagnostics
Select “Initial Configuration” . .
Server Configuration
Hetwork Configuration
Exit
13.| MPS B: —] Select running options |——
Ll
Select “yes”
Select OK and press [ENTER]
14. MPS B: Ruery for Firstiimeconfig::oSBackupliontig
I:l Enter the MAS root pasaword for NAS configuracion:: [INNENENEGEGN

Enter the NAS password used to
login into NAS console.




Select OK and press [ENTER]

15.| A message is displayed indicating the Database creation was successful.
A message is displayed indicating the NAS Backup Configuration was successful.

Select Exit and press [ENTER] repeatedly to exit Ismsmgr

card.

16.| MPS B: # minicom mate
O Log into the LSMS B server via
minicom.
17.| MPS A: #init6
Ll Perform init 6 to reboot the LSMS B
card. Watch for errors during boot process.
When the login prompt is displayed, exit from minicom.
18.| MPS A: # minicom mate
O Log into the LSMS A server via
minicom.
19.] MPSB: # init 6

L] perform init 6 to reboot the LSMS A | Watch for errors during boot process.
When the login prompt is displayed, exit from minicom.

This procedure is complete!

Procedure 13 CONFIGURE TIME ZONE AND CLOCK

Procedure 13 — Configure Time Zone and Clock.

S | This procedure configures the time zone and clock.
E Estimated time: 5 minutes
; Note: Below procedure needs to be executed on both MPS A and B servers.
1| MPSX: Logintothe | Login: root d
1| server as the user Password: <root_password>
“root”.
MPS X: Start # su - lsmsmgr
2| Ismsmgr utility by
[ logging in as
Ismsmgr user.
MPS X:: Verify time | Select Server Configuration and press [ENTER].
3| zone.
L]
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——— Main Menu ——

Initial Configuration
Maintenance
Diagnostics

Hetwork Configuration
Exit

Select Time Zone and press [ENTER].

| Server Configuration Menu |

Set Clock

Time Zone

Exit

The screen shows the current time zone setting.

Lagaqagkgl qagagak]
maggaagl mggagad]

[moggggggggaygggagaggad

If this is not correct, select Edit and press [ENTER].

If the time zone is correct, select Exit, press [ENTER] and skip the next step

MPS X: Change time
zone.

Select appropriate time zone and press [ENTER].




1ggggogou Select Time Zone Menu tggogagak

kmerica/Mazatlan
kmerica/Mendoza
Imerica/Menominee
kmerica/Merida
Imerica/Metlakatla
America/Mexico City
America/Miquelon
kmerica/Moncton
America/Monterrey
Imerica/Montevideo
Imerica/Montreal
Imerica/Montserrat
Imerica/Massau

JHew York

P

America/Nipigon
America/Home
America/Noronha

[~ I I
A

MoM OB oM OM oM MM MM MMMMMMMNMHN

1l (a2 o {0 (o 2 0o {8 (o 2 {0 {8 (o o {0 {0 (o a0 {0 o Lo 10 (i 0 (0 (o 0 (0 0 L 0

Select Yes to set the hardware clock to GMT and press [ENTER].
lggogggoggoaggu Time Zone tgggaggagoaggk
|2 il
Set hardware clock to GMT?

lgggggkfilggggk

x Ho =
mOgoga] mggad]

W H R K MHHAER
A

iuils {w fu o (s (s s g o o (s (0 o o o o o fn o [ s o o o s s o ]

MPS X: Set clock. Select Set Clock and press [ENTERY].
Server Configuration Menu

Select Edit and press [ENTER].

Options
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Enter correct time.
—| Change Date and Time |—

Use right arrow to get to OK and press [ENTER].

MPS X: Exit the
Ismsmgr menu

Select Exit and press [ENTER] to return to the Main Menu.
Server Configuration Menu F

Set Clock
Time Zone

Select Exit and press [ENTERY]. The “Ismsmgr” utility terminates.
Main Menu

Initial Configuration
Maintenance
Diagnaostics

Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 14 SINGLE SUBNET CONFIGURATION FOR LSMS MPS CARDS

Procedure 14 — Single Subnet Configuration for LSMS MPS Cards.

“root”.

'Sr This procedure configures the system as single subnet at the customer site.

¢ | Estimated time: 10 minutes

; NOTE: All the information should be taken before starting upgrade as part of Section 1.6
MPSA: Logintothe | Login: root d

1I.:| server as the user Password: <root_password>




MPS A: Start

# su — lsmsmgr

2| |smsmgr utility as
[ Ismsmgr user.

MPS A: Change the | Select Network Configuration and press [ENTER].
fj network configuration

— Main Menu |—

Initial Configuration

Maintenance =
Diagnostics =
Server Configuration
Hetwork Configuration E
Exit

Select Network Reconfiguration and press [ENTER].

-| Hetwork Configuration Memu |5

Hetwork Reconfigura
SHMP Configuration
Routing

NTP

IPS5EC Comfiguration
Modify Ho=sts File
Exit

tion

Select Yes to proceed to Network configuration.

lgggggggaggadadggggau Network Reconfiguration toogguooadadaaagaaaadk
-4

WAENING: This action is service impacting. Are you sure?

1ggggkil aggagk

morgorg] Moo

oM oM oMM oMM
L - S

iila o fs s (s fu {fufa o (o (s (s fa {s fw {ufufofo oo (s (afafuageiolsfsls(s(ss{afofoleolssfefsfsfslslofols (s (s (s ala o e o (s [sls s (s (s (s (o ]
A lynx driven screen will appear with the following prompt;

Do you want to execute “/usr/TKLC/Isms/tools/IsmsnetAdm-bin/Ismsnetadm.cgi”?

Type “Y/y” to continue and the next screen will appear and press the right arrow key to
follow the link

Select Single from the Subnet Type menu and then select Continue.
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agaqagadd]

Continue

MPS A: Enter
network values.

Using the up and down arrows, scroll through the text fields, entering the desired values ( to
enter the netmask, highlight the field and then use the enter key or right arrow key to
display the dropdown menu, choose the desired value from the list) for each fields:

: LE1632AB55

r Hostname :lsmspri

v: 192.168.59.250

: 192.168.59.30 Het [255.255.255.0__

IF: 192.168.59.31 Hetmask: [255.255.255.0 ]

IF: 192.16e8.59.32

IF: 192.168.59.250

: 10.250.32.10

Start Over
Submit

Once the values are entered press the down arrow to select the “Submit” button and press
the right arrow to follow the link.

Note: The System Number shall be as follows:
e LEYYWWMMXX
e Where:
o LE isthe new System Number Prefix for LSMS.
oYY =YEAR - year of the system shipment
o) Vr\1/_\N: (;NEEK — calendar week of the Y'Y year when the system is
shippe

o MM =MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle

o XX =number in line of systems shipped that week




MPS A: Apply
network settings

If the values pass a sanity test for validity, then the “Confirm” button will be visible. Use
the down arrow to select “Confirm” and press the right arrow to apply the changes. If the
sanity tests failed, the reasons will be stated. Use the left arrow key to go back to the edit

screen.

tion will capse a service interroption!

Confirm

The execution could take a few minutes, be patient. The screen will eventually report the
status of the completion. If an error occurs, contact My Oracle Support following the
instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.

5 Net Admin:

LE11111111

‘EM NUM
y E = single

0 close utiltity (press 'qg'

to go hack. l

Commands: Use arrow k
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MPS A: Exitthe Select Exit and press [ENTER]to return to the Main Menu.
Ismsmgr menu | Network Configuration Menu |4

Hetwork Reconfiguration
SHMP Configuration
Routing

HTP

IPSEC Configuration

Select Exit and press [ENTER]. The “platcfg” utility terminates.

Main Menu

Initial Configuration
Maintenance
Diagnostics

Server Configuration
Hetwork Configuration

This procedure is complete!

Note: To proceed, use one of the following methods:
Currently, root login is

disabled over IP 1. Login via Conserver

access. Log in directly as root using the conserver console.

2. Login via IP using admusr user
Log in over IP as admusr

Switch to root: # su
Enter the root password when prompted.

Procedure 15 SEGMENTED CONFIGURATION FOR LSMS CARDS

Procedure 15 - Segmented Configuration for MPS LSMS Cards

This procedure configures the system as segmented subnet at the customer site.

Estimated time: 10 minutes

NOTE: All the information should be taken before starting upgrade as part of Section 1.6

|:| P l#xom4dn

MPS A: Log in to the server
as the user “root”.

Login: root
Password: <root_password>




# su - lsmsmgr

2. | MPS A: Start Ismsmgr
] utility by login as Ismsmgr
user
3. | MPS A: Change the Select Network Configuration and press [ENTER].

network configuration
] g
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—— Main Menu |——

Initial Configuration

Maintenance B
Diagnostics B
Server Configuration

Hetwork Configuration E

Exit

Select Network Reconfiguration and press [ENTER].

-| Hetwork Configuration Menu |5

Hetwork Reconfiguration
SHMP Configuration
Routing

HTE

IPSEC Configuration
Modify Hosts File

Exit

Select Yes to proceed to Network configuration.
lgggogogoaogagagagagau Network Reconfiguration tododododoaoaoaqadd

WAENING: Thi=s action is service impacting. Are vou sure?

ik

Loaggaklagggak

4 Mnb:xiﬁﬁ'h
mogag] mgggga]

MoM oMM oMM MM

DOOaaaIaoIooooooaoaaaooaaaoaaqaooaoooooaqoooaqoaoaaaoaoqaooaoooooaoooooy
A lynx driven screen will appear with the following prompt;

Do you want to execute "//usr/TKLC/Isms/tools/IsmsnetAdm-
bin/Ismsnetadm.cgi"?

Type “Y/y” to continue and the next screen will appear and press the right arrow
key to follow the link

Select Segmented from the Subnet Type menu and then select Continue.

Continmoe

&>

MPS A:
Enter network values.

Using the up and down arrows, scroll through the text fields, entering the desired
values (to enter the netmask, highlight the field and then use the enter key or right

MoK oM MMM MK

o




arrow key to display the dropdown menu, choose the desired value from the list)

for each fields:

NPAC Network

NEA

APP Hetwork
APP VLAN ID:
ARPP I
APP

VIP: 192.

Hetwork

EMS I

EMS

-

Start Over

: LE11111111

192.168.60.250
’: 192.168.60.3 I [255.255.255.0 ]

C IP: 192.168.60.4 Hetm: 1 [255.255.255.0__ ]

159

Gat v: 192.168.59.250

P: 192.168.59.3 Hetm: 1 [255.255.255.0 1
IF: 192.168.59.4 Netm 1 [255.255.255.0_ ]

168.59.5

: 192.168.61.250

P: 192.168.61.38 Netm: 1 [255.255.255.0__ ]

IF: 192.168.61.51 Hetm : [255.255.255.0__]

IF: 192.168.59.250

0.250.32.10

Note: The System Number shall be as follows:
e LEYYWWMMXX

e  Where:
o

(o]
(0]

o}

O

LE is the new System Number Prefix for LSMS

YY = YEAR - year of the system shipment

WW=WEEK - calendar week of the Y'Y year when the system
is shipped

MM = MANUFACTURER (if other than TKLC) — Here 00 as
Manufacturer is Oracle

XX = number in line of systems shipped that week

*Default route should be the route of the APP IP address.
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Once the values are entered press the down arrow to select the “Submit” button
and press the right arrow to follow the link.

o1

MPS A: Apply network
settings

If the values pass a sanity test for validity, then the “Confirm” button will be
visible. Use the down arrow to select “Confirm” and press the right arrow to apply
the changes. If the sanity tests failed, the reasons will be stated. Use the left arrow
key to go back to the edit screen.

ue - - o

n will cause a service interruption'

Start Over

The execution could take a few minutes, be patient. The screen will eventually
report the status of the completion. If an error occurs, contact My Oracle Support
following the instructions on the Appendix E.

Type “q” and then “y” to exit the Network Configuration.




M3 Net
LE11111111
single

lemspri

rming local configuration...

se utiltity (press

Admin

Use arrow keys to move, ? 1} ' to quit '<-' to go ban;‘k.l

NOTE: If below error is observed after network configuration, run “systemctl
restart network” command after exiting from Ismsmgr menu.

# systemctl restart network

MPS A: Exit the Ismsmgr
menu
L]

o

Select Exit and press [ENTER] to return to the Main Menu.
| Network Configuration Menu |

Hetwork Reconfiguration
SHMP Conmfiguration
Routing

HTP

IPSEC Configuration
Modify Hosts File

Select Exit and press [ENTER]. The “platcfg” utility terminates.
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—] Main Menu |

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

This procedure is complete!

disabled over IP access.

Note: Currently, root login is[To proceed, use one of the following methods:

1. Login via Conserver
Log in directly as root using the conserver console.

2. Login via IP using admusr user
Log in over IP as admusr

Switch to root: # su
Enter the root password when prompted.

Procedure 16 TMN TOOLKIT AND MARBEN OSI LICENSE INSTALLATION

Note: Valid licenses need to be installed on both A and B LSMS servers. Refer to LSMS 14.0 Release Notes, section
3.3: Marben OSI and TMN Toolkit license key files, for details. Be sure to start the process at least 7 days before the
scheduled upgrade date. If needed, temporary TMN Toolkit and Marben OSI licenses are available on the Oracle
Software Delivery Cloud (edelivery.oracle.com) with the LSMS software.

Procedure 16 - TMN Toolkit and Marben OSI License Installation

? This procedure will install the TMN Toolkit and Marben OSI License to both A and B LSMS servers.
E
P Estimated time: 5 minutes
#
1. MPS X: Logintothe | Login: root
Ol O server as the user “root” Password: <root_password>
2 MPS X: Install the Copy the TMN Toolkit license file to /usr/local/netech/etc/license path following any steps

O O TMN toolkit license file

mentioned in 3.7C.1 or 3.7C.2

If upgrading from LSMS 14.0.0.X release copy backed up licenses on respective paths, there
will be no need to procure new licenses.

Open the file ¢/usr/local/netech/etc/license’ using vi or vim and copy the content of
license in the file and save the file.

Cross check the content of file using :
# cat /usr/local/netech/etc/license




MPS X: Install the
O 0O Marben OSI License
file

Copy Marben OSI License string using below command:
# echo "<Marben 0OSI Tlicense string>" > /usr/TKLC/osi/conf/1license

MPS X: Restart the
O system

Full Upgrade for LSMS 14.0

Reboot the system to take effect

# reboot
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Procedure 17 START LSMS SERVICES

Procedure 17 - Start LSMS services

S This procedure starts the LSMS services.
E Estimated time: 10 minutes
P
#
1 MPSA: Logintothe | Login: QQO‘C d
I:l server as the user Passworad: <root_password>
“root”.
9 MPS A : Check Run below command to check Tsms status is UNINITIALIZED
: "INHIBITED" before running startNode
[ hastatus
# hastatus
UNINITIALIZED
if status is UNINITIALIZED and not UNINITIALIZED "INHIBITED" run
hafailover else continue with Step 3.
# lusr/TKLC/plat/shin/hafailover --inhibit
# hastatus
UNINITIALIZED "INHIBITED"
3 MPS A: # su - lsmsmgr
0 Start Ismsmgr
4. MPS A: Start Node On the “Main Menu”, select Maintenance and press [ENTER].
O - This will make node Hain Hens

active and start
application

Initial Configuration

Maintenance

Diagnostics

Server Configuration
Network Configuration
Exit

Select Start Node and press [ENTER].
—4 Maintenance Menu

LSM5 NHode Status

Start Node

S5top Node

Inhibit Hode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]




4' Start Hode Ii

Confirm Node Startup

Select Exit and press [Enter] to return to Main Menu.
—| Maintenance Menu |—

LSM5 Hode S5tatus
Start Node

Stop Hode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
— Main Menu

Initial Configuration
Maintenance
Diagnostics
Server Configuration
Hetwork Configuration

5 MPS A: #ssh mate

: Switch to mate

L]

6 MPSB: Logintothe | Login: root

: server as the user Password: <root_password>
L]

“root”.
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# su - lsmsmgr

7. MPS B:
Start Ismsmgr
8. MPS B: Start Node On the “Main Menu”, select Maintenance and press [ENTER].

- This will make node
standby and start
application

4| Main Menu |7

Initial Comnfiguration

Diagnosticsa

Server Configuration
Network Configuration
Exit

Select Start Node and press [ENTER].

—4 Maintenance Menu F——

LSM5 Node Status

Start Node

Stop Node

Inhibit Hode
Backup and Restore
Exit

Select Yes to confirm node startup press [Enter]

4' Start Hode Ii

Confirm Node Startup

Press Enter once the node is uninhibited successfully.




Select Exit and press [Enter] to return to Main Menu.

—| Maintenance Menu |—

LSMS Node Status
Start Node

Stop HNode

Inhibit Hode
Backup and Restore

Select Exit and press [Enter] to exit the Ismsmgr menu.
— Main Menu

Initial Configuration
Maintenance
Diagno=stics
Server Configuration
Hetwork Configuration

This procedure is complete!

Procedure 18 POST CONFIGURATION HEALTH CHECK

Procedure 18 — Post Configuration Health Check

This procedure determines the health of the Server after an installation. This procedure will perform a
syscheck on each LSMS server.

HF Om-dw

Estimated time:5 minutes
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Login: root

1 _MPS Aand B: Log Password: <root_password>
| into the server as the
user “root”.
. # date
2.| MPS Aand B: Thu May 12 05:55:27 EDT 2016
] Validate date, time and
time zone to ensure
accuracy.
MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of mated
Execute the “hastatus”| LSMS pair.
command to verify the # hastat
HA state of this server. astatus
Verify that the hastatus of one of the servers is Active and the other is Standby.
WARNING: If the output from the above command is anything else other than
“ACTIVE” and “STANDBY™, do not proceed with this procedure and contact My
Oracle Support following the instructions on the Appendix E.
3. | LSMS Standby server; | Execute the following command to verify that MySQL replication is working correctly
Ol Verify that the on the STANDBY LSMS server:
STANDBY server’s # tail /var/TKLC/1sms/logs/dbreplmon.Tog
MySQL replication is | 1t mySQL replication is functioning correctly then the following output will be
functioning properly. | ohserved, make sure that at least the last line of your output matches the lines below.
Thu May 12 05:58:12 2016 A1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 05:59:19 2016 AT1 tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:00:25 2016 Al1l tests passed on STANDBY
FIPS integrity verification test failed.
FIPS integrity verification test failed.
Thu May 12 06:01:32 2016 ATTl tests passed on STANDBY
WARNING: If at least the last line of your output does not match the lines above then
do not proceed with this upgrade and contact My Oracle Support following the
instructions on the Appendix E.
4. | MPSA and B: # syscheck
[J| Execute syscheck Running modules in class disk...

OK
Running modules in class hardware...

OK
Running modules in class Tsmshc...

OK




Running

Running

Running

Running

Running

modules

modules

modules

modules

modules

in

in

in

in

in

class

class

class

class

class

LOG LOCATION: /var/TKLC/log/syscheck/fail_log

net...
OK
proc...
OK
services...
OK
system. ..
OK
upgrade...
OK

o

| Capture the output of

LSMS Active server: Execute the following command on the ACTIVE LSMS server to display the current
LSMS sentry status:

‘sentry status’ # sentry status

command NOTE: Verify that the output displays a Status of “running” for all processes; the
regional processes (npacagents) may or may not be associated in the Comment field. If
the output from this command displays any other Status than “running” contact My
Oracle Support following the instructions on the Appendix E.

Capture the output from this command and make it available to Oracle Technical
Services if required.

This procedure is complete!

3.7 Data Migration

Procedure 19 RESTORE DATABASE

Procedure 19 - Restore Database

? This procedure restores the database on the LSMS server.
E | Estimated time:60 minutes
P
#
] Login: root
1 MPS A server: Password: <root_password>
1| Login to the server as the
user “root”.
2 | MPS A server: Transfer all the NPAC region DB snapshot files, supDB MySQL dump and users
[7| Copy the snapshot files MySQL dump from the Remote server to current LSMS A server.
from the Remote server to
the current LSMS Active Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
server. NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB
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# scp -p r_oot@<Remote IP>: <Remote IP Path>/mysql-snapshot-
<NPAC region>.tar.gz /var/TKLC/Tsms/free
Password: <root_password>

# scp -p root@<Remote IP>:<Remote IP Path>/supDBdump.sql
/var/TKLC/1sms/free
Password: <root_password>

# scp —-p root@<Remote IP>:<Remote IP Path>/
MySQLUserGrants.sql /var/TKLC/1sms/free

Password: <root_password>

Switch user to Ismsadm and create regional DB for all regions that were

3. | MPS A server: 3 1o LSMS bef redte
Create DB schema for all connected to LSMS before migration
A . # su — Ismsadm
regional DB for which
restore needs to be done $ npac_db_setup create <region name>
Note: Run above command for all regions
4, MPS A and B server: . . .
Note: Execute this step on Standby LSMS server first followed by the active
]| Stop LSMS processes LSMS server.

# su — lsmsmgr

4| Main Menu Ii

Initial Configuration

Diagno=stics

Server Configuration
Hetwork Configuration
Exit

—| Maintenance Menu |—

LSMS Hode S5tatus
Start NHode

Stop Hode

Inhibit Node
Backup and Restore
Exit

I Stop Node I

This could cause a service interruption, are you sure?




Hode shutdown completed successfully.

Press any key to continue...

Exit the Ismsmgr menu.
MPS A and B: Execute the following command on both LSMS A and B to verify the HA state of
[ 1| Execute the “hastatus” mated L.SMS pair.

command to verify the HA # hastatus
state of this server.

»~

Verify that the hastatus of both the servers is ‘UNINITIALIZED "INHIBITED"’.

WARNING: If the output from the above command is anything else other, do not
proceed with this procedure and contact My Oracle Support following the
instructions on the Appendix E.

5. MPS A server: # cd /var/TKLC/1sms/free
]| Extract the snapshot data
from the archive tar files Restore the <regionDB> with the regional database name (For example:
copied from LSMS. CanadaDB)
# tar -xzvf /var/TKLC/1sms/free/mysql-snapshot-
<regionDB>.tar.gz
# scp /var/TKLC/1sms/free/<regionDB>/*MY*
/var/TKLC/1sms/db/<regionDB>
# rm -rf /var/TKLC/Isms/free/<regionDB>
6. | MPS A server: Execute the below commands:

# systemct] start mysqld
]| Restore supDB and MySQL Y ysA
Users. Restore the ‘supDB’

# mysql -udbroot -p[dbroot_password] supDB <
/var/TKLC/1sms/free/supbBdump.sql

mysql -u dbroot -p<mysql_password> supDB -e 'UPDATE LsmsUser
set FirstLogonFlag=1;'

Restore MySQL users
# mysql -udbroot -p[dbroot_password] <
/var/TKLC/1sms/free/MySQLUserGrants.sql

# systemctl stop mysqld

Note: Below warning message can be ignored if displayed:
warning: Using a password on the command Tline interface can
be insecure.
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MPS A server:

Remove the shapshot files

Remove the snapshot files.

cd /var/TKLC/1sms/free
rm —f mysql-snapshot-*
rm —f supbDBdump.sql

rm —-f MySQLUserGrants.sql

HHHH

©

MPS A server:

Check ownership of
database files

Verify dbadm:dbadm ownership of all database files and
directories.

# cd /var/TKLC/1sms/db
# 1s -1tr <DB Name>

where <DB NAME> is supDB or <region>DB,
where <region> is the name of an NPAC region.

If any databases have ownership other than dbadm:dbadm, change them using
this command:

# chown -R dbadm:dbadm <DB NAME>

©

MPS A and B server:
Start LSMS processes

Note: Execute this step on LSMS A server first followed by LSMS B server.

Run the below command to check if Isms status is UNINITIALIZED
"INHIBITED" before running startNode.

# hastatus
UNINITIALIZED

If the status is UNINITIALIZED and not UNINITIALIZED "INHIBITED", run
hafailover, else continue with Step 3.

#/usr/TKLC/plat/sbin/hafailo
ver--inhibit
# hastatus

UNINITIALIZED "INHIBITED"

# startNode

MPS A and B:
System Heath Check

Execute Procedure 18 to verify the system health check after DB full upgrade.

LSMS Active server:
Login to LSMS GUI

Login to LSMS Active GUI as Ismsall user.

LSMS Active server:
Configure MySQL Port

Refer to the recorded value of MySQL Port in 28 Procedure 6 step 11.

If the MySQL Port is default port, then skip the next step.

Otherwise, go to “Admin -> MySQL Port -> Modify” and configure the port
recorded from LSMS 13.5.X.




13.

LSMS Active server:

Verify the ELAP
Credentials

Go to “Configure -> LNP System -> EMS -> View” to verify the ELAP
Credentials are identical to the recorded value of the ELAP Credentials in
Procedure 6step 12.

Otherwise, go to “Configure -> LNP System -> EMS -> Modify” and configure
the ELAP Credentials recorded from LSMS 13.5.X.

Note: Re-configure the EMS on LSMS with the details captured in Procedure 6,
step 8.

This procedure is complete!

Procedure 20 CONNECT LSMS 14.0.X TO NPAC

Procedure 20 - Connect LSMS to NPAC

S

*xoOm-H

This procedure connects the LSMS to the NPAC.

Estimated time:15 minutes
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NOTE: Execute this procedure only when the NPAC region is not visible on the LSMS GUI, after the DB is restored.

MPS X:
Verify LSMS installation

D!—‘

Note:

1. LSMS 14.0.X is successfully installed and configured.
2. NAS s successfully installed and configured.

LSMS Active server:
Login to LSMS Active GUI

o

Login to LSMS Active GUI through VIP as Ismsall user.

LSMS Active server:
Update NPAC Customer ID
if required

Note: If after restore NPAC
ID is coming as it was

e

Click on the NPAC region.

Go to the menu Configure -> LNP System -> LSMS -> Modify

Enter the new LNP SPID in the ‘NPAC Customer ID’ field and fill appropriate
information in all other fields.

before starting upgrade skip Modify LNP Syster LSMS
this step
NPAC Customer 1D
Component info Contact Info
System Type LEMS Owmner 1D T
Platform Type LEMS Platform Supplier Oracle
Platform SW Release (130 Platform Model 1
j ? Modify LSMS Componemt?
oK Cancel
4. | LSMS Active server:

[]| Create NPAC region(s) and
connect it to the NPAC

Click on the NPAC region.

Go to the menu Configure -> LNP System -> NPAC -> Modify -> Primary
Enter the NPAC IP in the ‘NSAP’ field and NPAC FTP Address and check the
‘Activate Region’ checkbox. Fill the information in all other tabs.




5% Modify LNP System NPAC <MidAtlantic, primary> ==

SMS Name |Mid-Atlantic Reginnal NPAC SMS | [¥] Activate Region

fﬁ\ddress Info rCumpunent Info r Contact Info rCumm Info |
MPAC OS] Address

PSEL [cwl | SSEL[cwl | TSEL| | nzap (10 248 |10 5 |

LimE 05| Address
PSEL psel S5EL ssel TSEL MN5AP 10 248 10 78

MPAC FTP Address

[10 [z48 |10 |5 |

E Modify NPAC Component?

This procedure is complete!

Procedure 21 EXPORT THE DATABASE FROM LSMS 14.0.X TO THE QUERY SERVER

Procedure 21 — Export the Database from LSMS 14.0.X to the Query Server

1| Login as root.

S | This procedure provides the steps to export the database from the LSMS 14.0.X system to the query server.
E Estimated time:30 minutes
P
#
1. | LSMS Active server:

Login to LSMS 14.0.X CLI as root user.

2. LSMS Active server: 4 / JTRLC/1 /£ / 1 hot—*
- rm /var sms/free/mysql-snapshot-

|:| ;earggf\]/gtt?ﬁ:sx's“ng DB # rm /var/TKLC/lsms/free/snapinfo.sql

3. LSMS Active server: # 1smsdb —c snapshot

[]| Create asnapshot

WARNING: This command may cause a brief interruption in
traffic being sent

from the NPAC to connected network elements and Tocal LSMS
provisioning may be INTERRUPTED.

Do you want to continue? [Y/N]Y

Creating snapshot of the database partition, please wait...
Tvcreate -- WARNING: the snapshot will be automatically
disabled once it gets full

Tvcreate -- INFO: using default snapshot chunk size of 64 KB
for "/dev/vgapp/dbbackup"

Tvcreate -- doing automatic backup of "vgapp"

Tvcreate -- Togical volume "/dev/vgapp/dbbackup"
successfully created

The database is available to the application again.
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Disk snapshot created successfully.
mount: block device /dev/vgapp/dbbackup is write-protected,
mounting read-only

Snapshot mounted successfully.
Created snapinfo.sql file successfully
CanadabB/

CanadabB/db.opt
CanadabB/Subscriptionversion. frm
CanadabB/Subscriptionversion.MYl
CanadabB/Subscriptionversion.MYD
CanadaDB/NumberpPool1Block.frm
CanadabDB/NumberpPool1Block.MYI
CanadabDB/NumberpPool1Block.MYD
CanadaDB/ServiceProvNetwork. frm
CanadaDB/ServiceProvNetwork.MYI
CanadaDB/ServiceProvNetwork.mMYD
CanadaDB/ServiceProvLRN.frm
CanadaDB/ServiceProvLRN.MYI

(truncated )
Tvremove -- doing automatic backup of volume group "vgapp"
Tvremove -- logical volume "/dev/vgapp/dbbackup"

successfully removed

»~

LSMS Active server:
Verify the snapshot

# cd /var/TKLC/Tsms/free

[root@lsmspri freel# 1s
mysqgl-snapshot-SouthwestDB.tar.gz
mysql-snapshot-supDB.tar.gz
mysql-snapshot-CanadaDB.tar.gz
mysql-snapshot-westCoastDB.tar.gz
mysqgl-snapshot-MidAtlanticDB.tar.gz
shapinfo.sql
mysql-snapshot-MidwestDB.tar.gz
mysql-snapshot-NortheastDB.tar.gz
mysql-snapshot-SoutheastDB.tar.gz

o

LSMS Active server:

Copy snapshot files to
LSMS 14.0.X Query Server
or a Remote Server.

Transfer all the NPAC region DB snapshot files.

Note: The NPAC regions are: CanadaDB, MidAtlanticDB, MidwestDB,
NortheastDB, SoutheastDB, SouthwestDB, WestCoastDB and WesternDB

# scp -p /var/TKLC/1sms/free/mysql-snapshot-<NPAC
region>.tar.gz root@<Query Server IP>:/usr/mysqll

# scp -p /var/TKLC/1sms/free/snapinfo.sql root@<Query
Server IP>:/usr/mysqll

or

# sftp <username>@<IP address of remote computer>
Connecting to <IP address of remote computers...

The authenticity of host '<IP address of remote computer>'
can't be established.

DSA key fingerprint is
58:a5:7e:1b:ca:fd:1d:fa:99:f2:01:16:79:d8:b4:24.

Are you sure you want to continue connecting (yes/no)? yes
warning: Permanently added '<IP address of remote computer>'
(DSA) to the 1ist of known hosts.

<username>@<IP address of remote computer>'s password:

sftp> cd <target directory>

sftp> put mysql-snapshot-<NPAC regjon>.tar.gz
UpTloading mysql-snapshot-<NPAC region>.tar.gz




sftp> put snapinfo.sql
Uploading snapinfo.sql
sftp> bye
6. LSMS 14.0.X Query Jogin: root
H Server: Password:<root_password>
Login as root to the Query
Server
7. | LSMS14.0.X Query # cd /opt/mysql/mysql/bin
] Server: # ./mysqladmin -u root -p shutdown
Shutdown the Mysql server | Enter password:
8 | LSMS14.0.X Query # cd /usr/mysqll
] Server: # gunzip -c mysql-snapshot-<regionDB>.tar.gz | tar -xvf -
Extract the data for EACH
region. Replace regionDB
with regional database name
# rm mysql-snapshot-<regionDB>.tar.gz
Remove each tar.gz after it
has extracted.
9. LSMS 14.0.X Query # cd /opt/mysql/mysql/bin
] Server:
Start the Mysql daemon on
the Query Server. # ./mysqld_safe --skip-replica -start &
1255
# Sstarting mysqld daemon with databases from /usr/mysqll:
10. | LSMS 14.0.X Query # ./mysql -u root -p
] Server:
Start the Mysgl command
line utility mysql> RESET BINARY LOGS AND GTIDS;
Query OK, 0 rows affected (0.23 sec)
Reset the configuration
information for master
mysql> reset replica;
Query OK, 0 rows affected (0.19 sec)
Reset the configuration
information for slave mysql> source /usr/mysqll/snapinfo.sql
Query OK, 0 rows affected (0.17 sec)
Configure the query server
to start replication from the
correct position on the
master.
LSMS Active server: As
|1:1i the root user, remove the [root@lsmspri root]# rm /var/TKLC/1sms/free/mysql-snapshot*
intermediate tarballs from
the LSMS 14.0.X server.
As the root user, remove the | [root@lsmspri rootl# rm /var/TKLC/1sms/free/snapinfo.sql
snapinfo.sql script from the
LSMS 14.0.X server

Full Upgrade for LSMS 14.0

14.0

084



12. | LSMS 14.0.X Query NOTE :
] Server: EMS changes may cause the Query server to disconnect. These
Start the Mysgl command steps will help prevent the disconnect.
line utility login: root
# 9opt/mysq1/mysq1/b1n/mysq1 -u root -p
13. | LSMS 14.0.X Query mysql> SET GLOBAL SQL_REPLICA_SKIP_COUNTER = 100;
[]| Server: Query OK, 0 rows affected
Prepare the Query Server
for the EMS Configuration
14. | LSMS 14.0.X Query Perform Error! Reference source not found..
] Server:
Validate the operation of the
query server.

This procedure is complete!

Procedure 22SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

ELAP 10.2 server

STEP | This procedure exchanges SSH keys between the ELAP and LSMS 14.0 (TPD 8).
#
Note: This Procedure is only required when ELAP version is 10.2. Skip this procedure if ELAP version is 11.x
Estimated Time: 15 mins
Should this procedure fail, Contact Oracle technical services and ask for FULL UPGRADE ASSISTANCE.
. ] Togin: elapdev
L Active ELAP: Password: <elapdev_password>
Login as elapdev.
. . NOTE: RSA keys don’t exist on OL6 server ELAP 10.2. To
2. Active ELAP: exchange keys with LSMS 14, we need to generate RSA keys
Generate RSA keys on first on ELAP 10.2 server.

Please run below commands on the Active ELAP to generate
RSA keys on ELAP A and B servers.

1. Go to elapdev home directory using cd command.

cd

2. Generate key on local ELAP.

/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N "'

3. Generate key on remote ELAP

ssh mate "/usr/bin/ssh-keygen -t rsa -f .ssh/id_rsa -N

LI T3

Example:
[eTapdev@Ithaca-A ~]$ cd

[elapdev@ithaca-A ~]$ /usr/bin/ssh-keygen -t rsa -f
.ssh/id_rsa -N "'




Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Generating public/private rsa key pair.

Your identification has been saved in .ssh/id_rsa.
Your public key has been saved in .ssh/id_rsa.pub.
The key fingerprint is:

3e:d0:ea:25:fc:84:66:ff:4c:16:00:16:99:c8:ed:af
elapdev@Iithaca-A

The key's randomart image is:
+--[ RSA 2048] ---+
. O++ |

0.+.

I

I I
I I
| e |
| ..S . |
I I
I I
I I
I I

+ +

[elapdev@Ithaca-A ~]# ssh mate "/usr/bin/ssh-keygen -t rsa
-f .ssh/id_rsa -N "' “

3. Active ELAP:

Verify that the keys are
generated for elapdev user
on both ELAP A and B
serves.

Check that rsa keys are generated for the elapdev user on
local and mate using below command.

Run beTow commands to verify the keys.
$ 1s -1rt .ssh/id_rsa*
$ ssh mate 'ls -TIrt .ssh/id_rsa*'

Example:

[eTapdev@Crete-A ~]$ 1s -1rt .ssh/id_rsa*

-rw-r--r-- 1 elapdev elap 569 Mar 20 08:16 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:16 .ssh/id_rsa
[eTapdev@Crete-A ~]$ ssh mate 'ls -Trt .ssh/id_rsa*'
-rw-r--r-- 1 elapdev elap 569 Mar 20 08:17 .ssh/id_rsa.pub
-rw------- 1 elapdev elap 2602 Mar 20 08:17 .ssh/id_rsa
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Procedure 22 - SSH KEY EXCHANGE BETWEEN ELAP AND LSMS

Exchange secure shell keys with LSMS A server using below

4, Active ELAP: command.
Exchange Secure Shell
Keys with LSMS 14.0 .
Run beTow commands to exchange keys with LSMS.
SSH keys will first be 1. Exchange key with Tocal ELAP and LSMS.
h d between ELAP A .
z):é Eg?\;SAeaneg?hen ﬁusr[TKLc/m at/bin/keyexchange 1smsadm@lsmsAIpAddr --
between ELAPBandLsMs | <&Y=1d-rsa.pub 2>&1
A 2. Exchange Key with remote ELAP and LSMS
/usr/bin/ssh -1 elapdev mate -t
"/usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsAIpAddr --
key=id_rsa.pub 2>&1"
Example:
[eTapdev@Ithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Ismsadm@10.75.140.10 --key=id_rsa.pub 2>&1
The server does not know of 10.75.140.10.
will just exchange host keys for the name given!
Password of 1smsadm:
ssh is working correctly.
. . Exchange secure shell keys with LSMS B server using below
5. Active ELAP: command.
Exchange Secure Shell
Keys with LSMS 14.0 Run below commands to exchange keys with LSMS.
1. Exchange key with Tocal ELAP and LSMS.
SSH keys will next be .
exchanged between ELAP A /usr/TKLC/plat/bin/keyexchange 1smsadm@lsmsBIpAddr --
and LSMS B and then key=id_rsa.pub 2>&1
between ELAP B and LSMS 2. Exchange Key with remote ELAP and LSMS
B
/usr/bin/ssh -1 elapdev mate -t
"/usr/TKLC/pTat/bin/keyexchange 1smsadm@lsmsBIpAddr --
key=id_rsa.pub 2>&1"
Example:
[eTapdev@Ithaca-A ~]$ /usr/TKLC/plat/bin/keyexchange
Ismsadm@10.75.140.11 --key=id_rsa.pub 2>&1
The server does not know of 10.75.140.10.
will just exchange host keys for the name given!
Password of 1smsadm:
ssh is working correctly.
6. Active ELAP: Sdate
Note down date and
timestamp

This procedure is complete!



mailto:lsmsadm@10.75.140.10
mailto:lsmsadm@10.75.140.11

Procedure 2 CONNECT LSMS 14.0.X TO ELAP

Procedure 23 - Connect LSMS to ELAP

$ This procedure connects the LSMS to ELAP.
E | Estimated time:10 minutes
P
#
7. | ELAP Active server: Lodin to ELAP GUI th HV/IP as Uiadmi
(7| Login to ELAP GUI ogin to roug as uiadmin.
8. ELAP Active server: Got Maint LSMS C i ch Enabled
0 to menu Maintenance -> onnection -> ange enable
[1| Enable the LSMS Click on ‘Enable LSMS Connection’ button.
Connection
ELAP_A_ NAME Change LSMS Connection Allowed
i INFO: The LEMS Connection is currently Disabled.
A CATTION: This action will Enable the L5235 Connection
AR 2013@ Tekelee, Ine, All Rights Reserved.
ELAP_A_NAME Change LSMS Connection Allowed
V SUCCESS: The L3MS Connection is now Enabled.
2013 © Tekelec, Inc,, All Rights Reserved.
9. | ELAP Active server: Go to menu Maintenance -> LSMS HS Bulk Download -> Change Enabled
Click on ‘Enable LSMS Bulk Download for the ELAP’ button.
Enable the bulkload.
ELAP_B_NAME Change LSMS HS Bulk Download Enabled
i INFO: The LSMS Bulk Download for this ELAP 1s currently Disabled.
& CAUTION: This action will Enable the LSMS Bulk Download for this ELAP.
Enable LSMS Bulk Download for this ELAP
= Copyright € 2013-2016, Oracle and/or its affiliates. All rights reserved.
After clicking on the button,success message will be displayed.
SUCCESS The LSMS HS Bulk Download is now enabled.
This procedure is complete!

Procedure 24 ACCEPT THE UPGRADE

Procedure 24 — Accept the upgrade.

This procedure will accept the upgrade.
Estimated time: 5 minutes

#+OMmMm—AW»w
>
@©
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MPS X: Log into the server| Login: root

as the user “root”. Password: <root_password>
MPS X: Start platcfg # su - platcfg
utility.

MPS X: Accept Upgrade

On the “Main Menu”, select Maintenance and press [ENTER].
Main Menu

Diagno=stics

Server Configuration
Hetwork Configuration
Bemote Consoles

Exit

Select the “Upgrade” menu and press [ENTER].
Maintenance Menu

Backup and Restore

View Mail Queues

Restart Server

Save Platform Debug Logs
Exit

Select the “Accept Upgrade” menu and press [ENTER].

4| Upgrade Menu Ii

Validate Media

Early Upgrade Checks
Initiate Upgrade

Copy USE Upgrade Image

Reject Upgrade
Exic

Note: The “Reject Upgrade” menu is also available after the LSMS installation.
However, this option should not be used after the first installation of application. It
should be used in subsequent upgrades to return to a previous application release.

Select Yes and press [ENTER].




I Main Menu I

Do you really want to accept the upgrade?

This procedure is complete!
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APPENDIX A. ISO IMAGE COPY FROM USB MEDIA

Assumption: The USB media contains the desired LSMS ISO.

Al

ISO IMAGE COPY FROM USB MEDIA

Appendix A.1 - ISO Image copy from USB media

S This procedure provides instructions to copy an ISO image from an USB media.
T
E|1A| 1B
P
#
1 | O] | MPSX: Insert Insert media in USB drive
USB.
2. O O] MPSX: Loginto [hostname] consolelogin: root
the server as the password: password
“root” user.
3.| | 1] MPS X:Run Execute the following command:
syscheck tomake | # syscheck
sure there is no The output should Took like:
error. [root@hostname ~]# syscheck
Running modules in class proc...
(0]
Running modules in class services...
(0]
Running modules in class system...
(0]
Running modules in class disk...
(0]
Running modules in class hardware...
(0]
Running modules in class net...
0K
LOG LOCATION: /var/TKLC/log/syscheck/fail_log
4. | [J| O| MPS X: Verify ISO| Execute the following command to perform directory listing:
image doesn’t # 1s -al /var/TKLC/upgrade
already exist. .
y exi The output should look like:
[root@hostname ~]# 1s -al /var/TKLC/upgrade
total 16
dr-xr-xr-x 2 root root 4096 Oct 22 16:31 .
dr-xr-xr-x 21 root root 4096 oct 18 13:40 ..
If an ISO image exists, remove it by executing the following command:
# rm -f /var/TKLC/upgrade/<ISO image>
51 1| 1| MPS X: Delete Execute the following command to create a directory to mount the USB media:
unwanted 1SOs # mkdir -p /mnt/usb
from USB media. ) )
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl * 1 812 831472 6
FAT16
Execute the following command to mount the USB media using the USB drive
name from the output above:




# mount /dev/sdcl /mnt/usb

Execute the following command to perform directory listing and verify the file

name format is as expected:
# 1s -al /mnt/usb

The output should look like:

[root@hostname ~J]# # 1s -al /mnt/usb

total 629400

dr-xr-xr-x 2 root root 4096 Dec 5 13:33 .

dr-xr-xr-x 22 root root 4096 Dec 5 13:55 ..
-rw-r--r-- 1 root root 829595648 Dec 5 16:20 LSMS-
14.0.0.0.0_140.6.5-x86_64.1s00nly one ISO file should be listed, if
additional files are listed, execute the following command to remove unwanted

I1SOs:
# rm -f /mnt/usb/<ISO_NAME>.iso

Fore.g.,
# rm —f /mnt/usb/ LSMS-14.0.0.0.0_140.6.5-x86_64.1s0

6. | 1| | MPS X: Verify
space exists for
ISO.

Execute the following command to verify the available disk space:

# df -h /var/TKLC

The output should Took Tike:
[root@Ismspri Togl]# df -h /var/TKLC
Filesystem Size Used Avail Use% Mounted on
/dev/mapper/vgroot-plat_var_tklc
3.9 1.2G 2.5G 32% /var/TKLC

Verify that there is at least 620M in the Avail column. If not, clean up files
until there is space available.

CAUTION: Make sure you know what files you can remove safely before
cleaning up. Itis recommended that you only clean up files in the
Ivar/TKLC/upgrade directory as this is a platform owned directory that
should only contain ISO images. This directory should not be expected to
contain images for any length of time as they can get purged. Contact
Technical Services beforehand if removing files other than the
/var/TKLC/upgrade directory as removing files is dangerous.

7.1 | O/ Copy iso from
mounted path to
the destination
path

Execute the following command to copy 1SO:
# cp /mnt/usb/<xyz.iso> /var/TKLC/upgrade/

Execute the following command to unmount the USB media:
# umount /mnt/usb

8. | | | MPSX: Verify ISO
image exists.

Execute the following command to perform directory listing:
# Is —al /var/TKLC/upgrade

The output should look like:

The output should look like:

[root@lsmspri Tog]# 1s -al /var/TKLC/upgrade

total 895152

drwxrwxr-x. 2 root admgrp 4096 Apr 20 17:16 .

dr xr-xr-x. 20 root root 4096 Apr 20 18:01 ..
———————— 1 admusr admgrp 916621312 Apr 20 17:16 LSMS-

14000014065x8664‘|so

Repeat this procedure from step 5 if LSMS ISO file is not as expected.
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9. | 11 ]| MPS X: Logout Logout from the server by executing the following command:
from server.
# logout
10.| ]| []| MPS X: Remove Remove media from USB drive.
USB media.

This procedure is complete!

A.2 Copying LSMS backups from NAS to USB

S This procedure provides instructions to copy LSMS backups from NAS to USB.
T
E | NAS
P
#
1.| [ | NAS:InsertUSB. | Insert mediain USB drive
2.| [ | NAS: Log in to the| [hostname] consolelogin: root
server as the “root”| password: password
user.
3. O | NAS:Run Execute the following command:
syscheck tomake | # syscheck
sure there is no The output should Took like:
error. [root@hostname ~]# syscheck
Running modules in class proc...
oK
Running modules in class services...
oK
Running modules in class system...
oK
Running modules in class disk...
oK
Running modules in class hardware...
oK
Running modules in class net...
oK
LOG LOCATION: /var/TKLC/Tog/syscheck/fail_log
4. [J | NAS: Mountthe Execute the following command to create a directory to mount the USB media:
USB media. # mkdir -p /mnt/usb
Execute the following command to get the USB drive name:
# fdisk -1 |grep FAT
The output should look like:
/dev/sdcl  * 1 812 831472 6
FAT32
Execute the following command to mount the USB media using the USB drive
name from the output above:
# mount /dev/sdcl /mnt/usb
Note: There should be space available in the USB. If not, clean up files until
there is space available.
5. [ | Copy backup files | Execute the following command to copy ISO:
to the mounted # cp <backup files> /mnt/usb/
path




While copying backup files to USB, Following error is expected:

cp: failed to preserve ownership for “/mnt/usb/<backup_file>': Operation
not permitted

Note: Please note the ownership of the backup files before copying. Therefore,
after restoring the backups to server after IPM’ing, verify the ownership of

backup files. If not matched, change the ownership with the “chown” command.

6.| 1 | NAS: Verify
backup files exists

Execute the following command to perform directory listing:
# Is —al /mnt/usb/

List of backup files should be displayed.

Execute the following command to unmount the USB media:
# umount /mnt/usb

7.1 [] | NAS: Logout from
server.

Logout from the server by executing the following command:

# logout

8.1 [ | NAS: Remove
USB media.

Remove media from USB drive.
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APPENDIX B. START AND VERIFY REPLICATION ON QUERY SERVER

Appendix B — Start and Verify REPLICATION ON Query Server

Start Replication.

Verify the replication
status on the Query
Server.

NOTE:

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to YES, the status is
good and the next
step can be skipped.

If the
Slave_IO_Running
and
Slave_SQL_Running
column values are set
to NO, wait a few
minutes and then
repeat the “show
slave status \G;”
command

If the values are still
NO, proceed to the
next step.

mysql> start slave;

S | This procedure provides the steps to start and verify Replication on the query server
T
E | This step is performed only if a query server exists in the customer system.
P | Estimated time:30 minutes
#
1. | LSMS14.0.X
Query Server:

Query OK, 0 rows affected (0.00 sec)

mysql> show slave status \G;

eddedededededededededededdedededededhdedeihd ]
Slave_IO_State:

Master_Host:

Master_uUser:

Master_Port:

connect_Retry:

Master_Log_File:

Read_Master_Log_Pos:

Relay_Log_File:

Relay_Log_Pos:

Relay_Master_Log_File:

Slave_IO_Running:

Slave_SQL_Running:
Replicate_Do_DB:
Replicate_Ignore_DB:
Replicate_Do_Table:
Replicate_Ignore_Table:

Fedede e ddefdddfhd

row Tehdedhde TN Nhd
waiting for master to send event
<Master Host IP>

Tsmsrepl

3306

60

mysql-bin.000134

15778725
cs2-bss2-relay-bin.000001
4137221

mysq1-bin.000134

Yes

Yes

ResyncDB,mysql

SupDB.LsmsUsersSpid, supDB. LsmsUser, supDB.DbConfig

Replicate_wild_Do_Table:
Replicate_wild_Ignore_Table:

Last_Errno:

Truncated..........

Seconds_Behind_Master:

1 row in set (0.00 sec)
mysql>

ResyncDB.%, supDB.%Key,mysql.%
1008

NULL




LSMS 14.0.X # tail /usr/mysqll/*.err

uery Server:
Query Record error here:

OPTIONAL:

D If the

Slave_IO_Running Contact My Oracle Support following the instructions on the Appendix E and ask for

and
Slave_SQL_Running FULL UPGRADE ASSISTANCE.

column values are set
to NO, the status is
not good and the
error will need to be
investigated.

Look at last few lines
of error log, and
record the error.
LSMS Active
Server:

. Login: Tsmsadm
D Lo_gln tothe LSMS Password: <lsmsadm_password>
Primary server as

Ismsadm.

w

[Tsmsadm@Ismspri Tsmsadm]$ Tsmsdb -c queryservers
cs2-bss2 (<Query Server IP>) Connected

D Verify the Query

Server is Connected.
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APPENDIX C. COPYING LICENSE FILE ON THE LSMS SERVER

C.1 Copying File Using SCP

This procedure will help copying the license file from a desktop to LSMS server

D:—*it"UmHm

Server X: Login to
server where license file
is present

Loging to server using ID and password where license file is copied

»

Server X: SCP the file
from server to LSMS
server

scp <license fiTe> root@<LSMS IP>: /usr/Tocal/netech/etc/Ticense

e

LSMS MPS: Check if
the license file has been
copied correctly

Run command to check for license file :
$ cat /usr/local/netech/etc/Ticense
Expected Output :

Contents of license file should be displayed

This procedure is complete!

C.2 Copying File Using USB
S | This procedure will help copying the license file from a desktop to LSMS server
T
E
P
#
1. [ Server X: Copy license | Connect USB to desktop and copy the license file from desktop to USB.
L] file to USB
2. | LSMS MPS: Confirm | Connect the USB to LSMS MPS which contains the license file and check on how it is
L how the USB is enumerated using command :
enumerated on LSMS | $dmesg | grep -i "removable disk"
server Expected output
sd 6:0:0:0: Attached scsi removable disk sdc
This shows USB is enumerated as /dev/sdc
3. | LSMS MPS: Determine | Run command fdisk —I on enumerated name device to determine partition name :
L} the partition name $fdisk —I /dev/sdc

Expected Output :

Disk /dev/sdc: 2013 MB, 2013265920 bytes

256 heads, 63 sectors/track, 243 cylinders
Units = cylinders of 16128 * 512 = 8257536 bytes

End

Device Boot
110

/dev/sdcl

Start Blocks Id System

887008+ b w95 FAT32

This shows that partition name is /dev/sdcl




4. | LSMS MPS: Copy Run below command to copy the license file from USB
O\ license file fromUSBto| $mkdir —-p /tmp/usb
MPS $ mount /dev/sdcl /tmp/usb
5. | LSMS MPS: Copy $ cp /tmp/usb/<license-file> /usr/local/netech/etc/license
U] license file from /tmp
directory

LSMS MPS: Check if | Run command to check for license file :
the license file hasbeen | $ cat /usr/local/netech/etc/1license

copied correctly

e

Expected Output ;
Contents of license file should be displayed

LSMS MPS: Unmount | Unmount the USB using command :
the USB $umount /tmp/usb

b

This procedure is complete!
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APPENDIX D. SWOPS SIGN OFF.

Discrepancy List

Date

Test
Case

Description of Failures and/or Issues.
Any CSR’s / RMA’s issued during
Acceptance. Discrepancy

Resolution and SWOPS
Engineer Responsible

Resolution
Date:




APPENDIX E. MY ORACLE SUPPORT

ACAUTION: Use only the guide downloaded from the Oracle Technology Network (OTN)
(http://www.oracle.com/technetwork/indexes/documentation/oracle-comms-tekelec-2136003.html).

Before upgrading your system, access the My Oracle Support web portal (https://support.oracle.com) and review any
Knowledge Alerts that may be related to the System Health Check or the Upgrade.

Before beginning this procedure, contact My Oracle Support and inform them of your upgrade plans. If installing for an
Oracle customer on a customer site, obtain the customer's Support Identifier (SI) before requesting assistance.

Web portal (preferred option): My Oracle Support (MOS) (https://support.oracle.com/)

Phone: Contact your local Oracle Global Customer Support Center (http://www.oracle.com/support/contact.html)

Make the following selections on the Support telephone menu:

1. Select ‘2’ for New Service Request
2. Select “3” for Hardware, Networking and Solaris Operating System Support

3. Select <1’ for Technical Issues and when talking to the agent, please indicate that you are an existing
Tekelec customer
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APPENDIX F. IMPORTANT STEPS/CHANGES IN THE DOCUMENT

This appendix highlights important updates to the document, as well as critical steps in the procedures that have

previously caused issues or may present challenges during execution.

1. Procedure 6, Step 9 is critical. Ensure you thoroughly review and understand this step before starting the upgrade

process. Failure to follow it correctly may result in issues that are difficult to resolve after the upgrade is complete.



